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Preamble 

This work: 

 was created, during the “Covid-19 quarantine”, for trainging purpose only 

 would introduce to Geographic Information System, QGIS and other Free/Libre Open Source 

Software (FLOSS) Software, information and open data. 

 

 

 

 

 

 

 

 

A part of this document is get from the net. Notes and links bring back, always, to the source. Each image is 

an hypertext that recall the original one[3].  

This work is published under the Creative Commons Attribution-ShareAlike 4.0 International (CC-BY-SA)[4][5]. 

All citations, images and tables that cames from “external source” follow their respective licenses. 

Before Starting 
To follow this document, these “ingredients” are need (according to Your System specifications): 

 QGIS (Software)  

 LibreOffice (or Microsoft Office) (Software) 

 a Text Editor (Notepad, Notepad++, Geany or other, similar) (Software) 

 An Internet Connection (to download QGIS Plugins and/or to display network background basemap) 

 Syria Cultural Site, Shapefile, from HDX[6] for Ex. “Add a Shapefile to QGIS” 

 Syria (Boundaries), Geopackage, from Gadm[7] 

 Mozambique Drought, Raster, from HDX[8] for Ex. “Add a Raster to QGIS” 

 World Heritage List, from WHC[9] for Ex. “From data to maps” 

If You are using a Windows PC (Desktop, Laptop…) and if You don’t want to install other software than QGIS 

probably You need “PortableApps”[10]. This application “Keep Work and Personal Separate”. “Use 

                                                           
3 Updated on 03/27/2020 
4 https://creativecommons.org/licenses/by-sa/4.0/ 

5 https://creativecommons.org/licenses/by-sa/4.0/legalcode 
6 https://data.humdata.org/dataset/syria-cultural-sites 
7 https://biogeo.ucdavis.edu/data/gadm3.6/gpkg/gadm36_SYR_gpkg.zip 
8 https://data.humdata.org/dataset/mozambique-drought 
9 https://whc.unesco.org/en/list/ 
10 portableapps.com 

http://creativecommons.org/licenses/by-sa/4.0/
https://creativecommons.org/licenses/by-sa/4.0/
https://creativecommons.org/licenses/by-sa/4.0/legalcode
https://data.humdata.org/dataset/mozambique-drought
https://www.qgis.org/it/site/
https://www.libreoffice.org/
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PortableApps.com for your personal apps on your work PC or for your work apps on your personal PC: 

Download for Free”. 

 

Figure 1 - The PortableApps Interface 

With the “Apps” button it is easy to browse and access to a variety of application: LibreOffice (Office App), GIMP (image 

editor), Inkscape (Vector Drawings), Scribus (Desktop Publishing), File and Disk utilities, Text Editor and so on. To 

download PortableApps and to get more applications an internet connection is required. 

“PortableApps” is available into several languages:  

 ,Bahasa Indonesia, Italiano, 日本語, Nederlands, Português Brasil ou Europeu ,עִבְרִית ,Deutsch, Español, Français ,عرب  

Pусский, Türkçe, 中文 (简体), 正體中文 (繁體) 

I suggest to use PortableApps installing, at least: 

 LibreOffice 

 Notepadd++ 

And, if You like, 

 Gimp 

 Inkscape 

 … 

Why use an open source software instead a proprietary one? 

“There are lots of reasons why people choose open source over proprietary software, but the most common 
ones are: 

 Peer review: Because the source code is freely accessible and the open source community is very 
active, open source code is actively checked and improved upon by peer programmers. Think of it as 
living code, rather than code that is closed and becomes stagnant. 

 Transparency: Need to know exactly what kinds of data are moving where, or what kinds of changes 
have happened in the code? Open source allows you to check and track that for yourself, without 
having to rely on vendor promises. 

https://portableapps.com/download
https://portableapps.com/ar
https://portableapps.com/de
https://portableapps.com/es
https://portableapps.com/fr
https://portableapps.com/he
https://portableapps.com/id
https://portableapps.com/it
https://portableapps.com/ja
https://portableapps.com/nl
https://portableapps.com/pt-br
https://portableapps.com/pt
https://portableapps.com/ru
https://portableapps.com/tr
https://portableapps.com/zh-cn
https://portableapps.com/zh-tw
https://portableapps.com/
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 Reliability: Proprietary code relies on the single author or company controlling that code to keep it 
updated, patched, and working. Open source code outlives its original authors because it is 
constantly updated through active open source communities. Open standards and peer review 
ensure that open source code is tested appropriately and often. 

 Flexibility: Because of its emphasis on modification, you can use open source code to address 
problems that are unique to your business or community. You aren’t locked in to using the code in 
any one specific way, and you can rely on community help and peer review when you implement 
new solutions. 

 Lower cost: With open source the code itself is free—what you pay for when you use a company like 
Red Hat is support, security hardening, and help managing interoperability. 

 No vendor lock-in: Freedom for the user means that you can take your open source code anywhere, 
and use it for anything, at anytime[11][12]. 

 Open collaboration: The existence of active open source communities means that you can find help, 
resources, and perspectives that reach beyond one interest group or one company”.[13] 

 

Figure 2 - Comparison of Open Sourceand Proprietary Software 

To investigate the reason «Why “Free Software” is better than “Open Source”» instead, it is possible to read 

the GNU dedicated page[14]. 

                                                           
11 “In economics, vendor lock-in, also known as proprietary lock-in or customer lock-in, makes a customer dependent on a vendor for products and services, unable to use another 

vendor without substantial switching costs. Lock-in costs that create barriers to market entry may result in antitrust action against a monopoly”. 

https://en.wikipedia.org/wiki/Vendor_lock-in 

12 Think about a particular data format that change on changing the software. Without paying for the last software version You’ll not be able to “access” the new format loosing on 

“interoperability”. 
13 https://www.redhat.com/en/topics/open-source/what-is-open-source 
14 https://www.gnu.org/philosophy/free-software-for-freedom.html 

https://www.redhat.com/en/topics/open-source/what-is-open-source
https://www.gnu.org/philosophy/free-software-for-freedom.html
http://cdn.differencebetween.net/wp-content/uploads/2018/04/Difference-Between-Open-Source-and-Proprietary-Software.jpg
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By the way, free software and/or open source software allow the user to be free, “participating” and 

“collaborating” to a common project: the freedom of knowledge. This opinion may explains by using a simple 

image: 

 

Figure 3 - Umbrella vs Mixing Bowl Culture 

The “Umbrella Culture” is a sort of shield that protect us but limit our freeedom; the “Mixing Bowl Culture” 

instead let us to share and improve our knowledge. 

  

https://darmano.typepad.com/logic_emotion/2009/05/is-your-organization-an-umbrella-or-mixing-bowl.html
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Conventions 

 

In this document: 

 

Symbol Description 

 

 

Highlight, Point of interest 

 

 

A Problem, a critical point… 

 

 

Final Action (i.e. press an “OK” button…) 

Text highlight in yellow would capture the attention 

This is a Text Hyperlink 

Settings ‣ Options ‣ General ‣ Locale follow QGIS Manual and show “single step” (for 
example, from the “Menu Bar”, go to the “Settings”, 
then “Option” then “Locale”… ) 

Ctrl+Alt+P is a shortcut 

 

 

 

 

 

A “Ballon Shape” with “some text” highlight a 
particular “area of interest” 

 

Table 1 –Conventions 

 

 

 

All the information and the links are updated on the date of the last revision: 

Revision Author Type (Draft/Final) Use (Private/Public) Date 

0 F. Fiermonte Draft Private 03/13/2020 

0.5 F. Fiermonte Draft Private 03/20/2020 

0.9 F. Fiermonte Draft Public 04/06/2020 

     

Table 2 - Document Revisions 

  

Some Text  
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Warnings 
Based on my experience, I feel to give You “ten suggestion” in order to work - I hope- in a “better” way. 

“GIS DECALOGUE” - Plus Edition 
1.a Do not use Windows Desktop (or other system folders such as “Documents”, “Downloads”, “Images” 

etc) to save Your files and/or Your Project[15][16] 

1.b Meditate and plan at well Your “working space” 

1.c Place the “working package” (project file, data and docs) into a convenient structure of folder[17] 

2. Use “relative path” option in Your GIS project always[18][19] 

3. Do not use files stored on USB pen drive and/or external HDD device[20] 

4.a Do not use long file names 

4.b Do not use long folder names  

5. Never use special characters, open quote, spaces and other “strange”symbols[21][22] 

6. Add suffix to file name to describe the process of data elaboration 

7. Remind to backup often Your data 

8. Use a Text Editor to track Your work 

9. Consider to “swich” from shapefile towards a GIS compliant structured container[23] 

10. (If Internet is OK) Prefer base maps “as services” (WMS, WCS, WFS) 

https://www.computerhope.com/jargon/s/specchar.htm 

For files or folders name, use “underscore” or “minus” character instead of special characters. 

 

  

                                                           
15 Windows Desktop (Documents, Downloads, etc) is not a “normal folder”. This path take the “user name” and put it into a predefinied path for example 

C:\Users\Administrator\Desktop\ (where the "Administrator" is the user). This do not follow rules #4.a; #4.b.  

16 https://answers.microsoft.com/en-us/windows/forum/windows_10-files/automated-windows-10-updates-deleted-all-my/33ce1539-788f-490e-9243-c3b2d3acab83 
17 For example, You could create a WORK directory. In this “root” folder You should save the QGIS project(s) files and in subfolders - starting from the "root" - place data, doc, output 

into separated folders. Maybe it is better to distinguish between “ORIGINAL DATA” from “MODIFIED DATA” (created by You) to preserve the original ones, downloaded,  from Your 

elaborations. This is a good method also to performes incremental backup. 

18 Refer to chapter “Project management” 
19 QGIS lets us to save our works into “projects” (QGZ or QGS format). When We save a project we store our work into a document in which the data we have used (vectors, rasters, 

services…) are linked to it and not embedded into the files. So, when we have to pass our work to a collegue is better to give a project containing, as pathname  “/WORK/” instead of 

“C:/WORK” to avoid a "corruption" of related objects. (If my collegue, to whom I gave the package, do not have the [c:\] drive and will save our project into [d:\] drive, when QGIS will 

try to open the project file will not be able to restore the data and will ask to us to re-established all the links). 

20 In general, external devices are slower than internal storage resources. And if we are not patient enough to wait until the end of saving procedures, we will risk disconnecting the 

device while the PC is still writing the data: a perfect storm (cat’s out of the bag) 
21 https://www.computerhope.com/jargon/s/specchar.htm 
22 For files or folders name, use “underscore” or “minus” character instead of special characters. 
23 A Geopackage, a PostgreeSQL-PostGIS database, a SpatiaLite Database… 

https://www.computerhope.com/jargon/s/specchar.htm
https://answers.microsoft.com/en-us/windows/forum/windows_10-files/automated-windows-10-updates-deleted-all-my/33ce1539-788f-490e-9243-c3b2d3acab83
https://www.computerhope.com/jargon/s/specchar.htm
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Introduction  

“Imagine you are flying from New York to Los Angeles. As the airplane descends over the L.A. basin, you look 

out the window. How would you describe what you see? [24] 

 

Figure 4 - The Los Angeles Basin 

“Because you cannot describe all the details of the complex cityscape below, you might break it down into 

objects: you might describe features such as buildings and streets, events such as a traffic jam, or phenomena 

such as a rainstorm. To describe the location of features, events, and phenomena, you might use terms such 

as "in front of" or "next to" or even geographic directions such as "north of the freeway" or "southwest of 

downtown." 

What you did was the first step in creating geographic data. You identified features, events, and phenomena 

and associated them with a location. In your head, you created a model of the cityscape below you. If you 

recorded this model by drawing a map, taking a photo, or just writing the information down on a piece of 

paper, the result would be geographic data.  

 

Figure 5 - A City Rendering 

Geographic data is recorded information about the earth's surface and the objects found on it, associated to 

a geographic location. In this module, you will learn more about geographic data—how it is organized and 

stored in a GIS, and how it can be assembled into a useful GIS database”.[25] 

                                                           
24 http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture05/concepts/ 

25 http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture05/concepts/ 

https://www.aopa.org/news-and-media/all-news/2017/november/flight-training-magazine/road-trip-la-basin
https://www.shelidon.it/?p=8298
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What is a Geographic Information System (GIS)? 

“A geographic information system (GIS) is a system designed to capture, store, manipulate, analyze, manage, 

and present spatial or geographic data. GIS applications are tools that allow users to create interactive 

queries (user-created searches), analyze spatial information, edit data in maps, and present the results of all 

these operations” [26] [27] 

 

Figure 6 - What is a Geographic Information System 

“GIS can refer to a number of different technologies, processes, techniques and methods. It is attached to 

many operations and has many applications related to engineering, planning, management, 

transport/logistics, insurance, telecommunications, and business”.[28]  

“GIS can relate unrelated information by using location as the key index variable. Locations or extents in the 

Earth space–time may be recorded as dates/times of occurrence, and x, y, and z coordinates representing, 

longitude, latitude, and elevation, respectively. All Earth-based spatial–temporal location and extent 

references should be relatable to one another and ultimately to a "real" physical location or extent”.[29] 

By the way, the power of GIS is the capatility to put into relationship the geographic information with data 

to create a System of Geographic Information. We can consider the first example of GIS the “Original map by 

                                                           
26 Clarke, K. C., 1986. Advances in geographic information systems, computers, environment and urban systems, Vol. 10, pp. 175–184. 

27 Maliene V, Grigonis V, Palevičius V, Griffiths S (2011). "Geographic information system: Old principles with new capabilities". Urban Design International. 16 (1): 1–6. 

doi:10.1057/udi.2010.25. 

28 Maliene V, Grigonis V, Palevičius V, Griffiths S (2011). "Geographic information system: Old principles with new capabilities". Urban Design International. 16 (1): 1–6. 

doi:10.1057/udi.2010.25. 

29 Wikipedia, GeEographic Information System, https://en.wikipedia.org/wiki/Geographic_information_system#cite_note-

Maliene_V,_Grigonis_V,_Palevičius_V,_Griffiths_S_2011_1–6-2 

https://www.edc.uri.edu/nrs/classes/NRS409509/Lectures/3GISdefined/5%20Points%20of%20GIS.jpg
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John Snow showing the clusters of cholera cases in the London epidemic of 1854, drawn and lithographed by 

Charles Cheffins”[30]. 

John Snow, “by talking to local residents (with the help of Reverend Henry Whitehead), identified the source 
of the outbreak as the public water pump on Broad Street (now Broadwick Street). Although Snow's chemical 
and microscope examination of a water sample from the Broad Street pump did not conclusively prove its 
danger, his studies of the pattern of the disease were convincing enough to persuade the local council to 
disable the well pump by removing its handle (force rod). This action has been commonly credited as ending 
the outbreak, but Snow observed that the epidemic may have already been in rapid decline. 

Snow later used a dot map to illustrate the cluster of cholera cases around the pump. He also used statistics 
to illustrate the connection between the quality of the water source and cholera cases”. 

 

Figure 7 - The  map by John Snow (clusters of cholera cases). Drawn and lithographed by Charles Cheffins 

“He showed that the Southwark and Vauxhall Waterworks Company was taking water from sewage-polluted 
sections of the Thames and delivering the water to homes, leading to an increased incidence of cholera. 
Snow's study was a major event in the history of public health and geography. It is regarded as the founding 
event of the science of epidemiology”.[31] 

What is QGIS? 

“QGIS is a professional GIS application that is built on top of and proud to be itself Free and Open Source 

Software (FOSS)[32]. 

                                                           
30 https://en.wikipedia.org/wiki/John_Snow#/media/File:Snow-cholera-map-1.jpg 
31 https://en.wikipedia.org/wiki/John_Snow 
32 http://freeopensourcesoftware.org/index.php/Main_Page 

https://en.wikipedia.org/wiki/Cluster_(epidemiology)
https://en.wikipedia.org/wiki/Charles_Cheffins
https://en.wikipedia.org/wiki/Reverend_Henry_Whitehead
https://en.wikipedia.org/wiki/Broadwick_Street
https://en.wikipedia.org/wiki/Broad_Street_pump
https://en.wikipedia.org/wiki/Hand_pump#Types
https://en.wikipedia.org/wiki/Dot_distribution_map
https://en.wikipedia.org/wiki/Southwark_and_Vauxhall_Waterworks_Company
https://en.wikipedia.org/wiki/Thames
https://en.wikipedia.org/wiki/Epidemiology
https://en.wikipedia.org/wiki/John_Snow#/media/File:Snow-cholera-map-1.jpg
https://en.wikipedia.org/wiki/John_Snow
http://freeopensourcesoftware.org/index.php/Main_Page
https://en.wikipedia.org/wiki/John_Snow#/media/File:Snow-cholera-map-1.jpg
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Figure 8 - QGIS Site 

QGIS is a user friendly Open Source Geographic Information System (GIS) licensed under the GNU General 

Public License[33]. QGIS is an official project of the Open Source Geospatial Foundation (OSGeo)[34]. It runs on 

Linux, Unix, Mac OSX, Windows and Android and supports numerous vector, raster, and database formats 

and functionalities. 

QGIS is a volunteer driven project. We welcome contributions in the form of code contributions, bug fixes, 

bug reports, contributed documentation, advocacy and supporting other users on our mailing lists and 

gis.stackexchange.com. If you are interested in actively supporting the project, you can find more information 

under the development menu and on the QGIS Wiki[35]. 

QGIS provides a continously growing number of capabilities provided by core functions and plugins. You can 

visualize, manage, edit, analyse data, and compose printable maps.  

To explore the QGIS features it is possible to use this link[36]. To get a a copy of QGis 3.10 User Guide use this 

link[37] instead”. 

                                                           
33 https://www.gnu.org/licenses/licenses.html 
34 https://www.osgeo.org/ 
35 https://en.wikipedia.org/wiki/QGIS 
36 https://docs.qgis.org/3.10/en/docs/user_manual/preamble/features.html 
37 https://docs.qgis.org/3.10/en/docs/user_manual/index.html 

https://www.gnu.org/licenses/licenses.html
https://www.gnu.org/licenses/licenses.html
https://docs.qgis.org/3.10/en/docs/user_manual/preamble/features.html
https://docs.qgis.org/3.10/en/docs/user_manual/index.html
https://www.gnu.org/licenses/licenses.html
https://www.osgeo.org/
https://en.wikipedia.org/wiki/QGIS
https://www.qgis.org/en/site/index.html
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How get the software? 

To get a copy of QGIS please follows “Download QGIS for your platform”[38] and choose the appropriate 

version: MS-Windows, macOS, Linux, BSD, Apps for mobile and tablet, and so on. 

If You are using a Windows Operating System I suggest the “Standalone installers from OSGeo4W packages” 

(check Your PC technical info to known if the system is running on 32 of 64 bit platform): 

*** Latest release (richest on features): 

* QGIS Standalone Installer Version 3.12 (64 bit) 

https://qgis.org/downloads/QGIS-OSGeo4W-3.12.1-1-Setup-x86_64.exe 

* QGIS Standalone Installer Version 3.12 (32 bit) 

https://qgis.org/downloads/QGIS-OSGeo4W-3.12.1-1-Setup-x86.exe 

*** Long term release repository (most stable): 

* QGIS Standalone Installer Version 3.10 (64 bit) 

https://qgis.org/downloads/QGIS-OSGeo4W-3.10.4-1-Setup-x86_64.exe 

* QGIS Standalone Installer Version 3.10 (32 bit) 

https://qgis.org/downloads/QGIS-OSGeo4W-3.10.4-1-Setup-x86.exe 

To download and use the “most stable version”, is better to refer to Long term release repository. 

How contribute to the Project (without donate money) 

Bugs, Features and Issues 

“QGIS is a largely volunteer driven project, and is the work of a dedicated team of developers, 

documenters, translators and supporters. Despite the efforts of the team to release QGIS without 

bugs, there may remain some bugs. If you find a bug or want new features to be added, please report 

it”! [39] 

Where to report? 

“Each part of the QGIS Project has a dedicated place where issues (feature requests or bugs) can be 

reported, managed and discussed. Depending on the area you encountered the issue, the table 

below indicates the right repository to report it: 

Place you found the bug or request a feature for: 

 Applications (QGIS Desktop, QGIS Server): https://github.com/qgis/QGIS/issues 

 QGIS Website (https://qgis.org): https://github.com/qgis/QGIS-Website/issues 

 QGIS Documentation (https://docs.qgis.org): https://github.com/qgis/QGIS-

Documentation/issues 

 External plugins: the author repository set in the plugin description 

For help and questions, please contact the Mailing lists”. 

                                                           
38 https://www.qgis.org/en/site/forusers/download.html 
39 https://qgis.org/en/site/getinvolved/development/bugreporting.html 

https://qgis.org/downloads/QGIS-OSGeo4W-3.12.1-1-Setup-x86_64.exe
https://qgis.org/downloads/QGIS-OSGeo4W-3.12.1-1-Setup-x86.exe
https://qgis.org/downloads/QGIS-OSGeo4W-3.10.4-1-Setup-x86_64.exe
https://qgis.org/downloads/QGIS-OSGeo4W-3.10.4-1-Setup-x86.exe
https://qgis.org/
https://docs.qgis.org/
https://www.qgis.org/en/site/forusers/download.html
https://qgis.org/en/site/getinvolved/development/bugreporting.html
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Reporting issues on QGIS applications 

“QGIS applications (QGIS Desktop and QGIS Server) issues are available in Github. In order to submit 

or comment a report, you need to register and login”. 

Before reporting an issue 

“Before filing an issue, review the currently open issues to make sure that you aren’t creating a 

duplicate. If you have additional information on an issue, you can add it to the existing ticket. Third 

party plugins might also cause problems. If you have installed any, you should also verify that the 

problem is still reproducible without them. Please don’t report multiple unrelated bugs in a single 

bug report. 

Before sending the report, please check the formatting of your report by clicking on “Preview”. Please 

avoid editing existing reports, if not for typos. Better add further comments in any other case”. 

QGIS Translation 

QGIS is natively developed in English, either for the user interface (GUI) or for its documentation and web 
site. However, all these components are available in many other languages since it is designed to be 
translated into any language quite easily. At this moment about forty languages are already available in the 
Desktop user interface and about eighty languages are available in transifex ready to be translated. Nearly 
the same apply for the web site and documentation. 

The translation process is managed by the Translation Team and all the activities are done under the 
Transifexplatform. 

QGIS GUI Translation 

The QGIS interface is natively programmed in English. However, at this moment over forty other languages 
are already available. 

To start QGIS with the appropriate localization, run qgis --lang<language code> in command line or change 

localization in QGIS under Settings ‣ Options ‣ General ‣ Locale menu. 

If you want to find out if your language is already present in QGIS Applications or who is currently working 

on your language you have to take a look in the Help ‣ About ‣ Translators Box in the QGIS Desktop 
Application. 

You will also find the progress of the translation there (but remember in every “stable” version it will always 
stay at the same level). For finding the current percentage of translation you will either have to install the 
nightly build of QGIS or checkout the source code of QGIS. 

The entire interface contains over ten thousand pieces of text and a complete translation will take days if not 
weeks to be finished. Besides that, the rapid development of the application continuously causes new and 
edited texts to be translated. A huge effort and your help will be appreciated! 

User Guide, Manuals and Tutorial 

QGIS 3.10 

For users:[40] 

 Read the QGIS User guide 

 Follow the tutorials in the QGIS Training manual 

 Learn GIS basics in A gentle introduction in GIS 

                                                           
40 https://www.qgis.org/en/docs/index.html 

https://qgis.org/en/site/getinvolved/governance/governance.html#gui-translation
https://www.transifex.com/
http://docs.qgis.org/3.10/en/docs/user_manual
http://docs.qgis.org/3.10/en/docs/training_manual/
http://docs.qgis.org/3.10/en/docs/gentle_gis_introduction
https://www.qgis.org/en/docs/index.html


                                                                                 A short intro to FLOSS, GIS, and QGIS 

For documentation writers: 

 Learn how to write docs using the Documentation Guidelines 

For developers: [41] 

 Go Python, study the PyQGIS cookbook (for plugins and scripting) 

 C++ Api documentation 

 PyQGIS - QGIS Python Api documentation 

QGIS testing 

We are still updating (not translating yet) the documentation for releases newer than QGIS 3.10. We call this 
version 'QGIS testing' and the documentation can be found here: http://docs.qgis.org/testing 

 User guide/Manual 

 QGIS Training manual 

 PyQGIS Cookbook 

 QGIS Developers Guide 

 Building QGIS from Source 

 Documentation Guidelines (how to write the docs) 

 A gentle introduction in GIS 

 PDF versions of all above, eg for printing are available here: http://docs.qgis.org/testing/pdf 

 C++ Api documentation 

 PyQGIS - QGIS Python Api documentation 

QGIS 3.4 

For users: 

 Read the QGIS User guide (or as PDF) 

 Follow the tutorials in the QGIS Training manual (or as PDF) 

 Learn GIS basics in A gentle introduction in GIS 

For documentation writers: 

 Learn how to write docs using the Documentation Guidelines 

For developers: 

 Go Python, study the PyQGIS cookbook (for plugins and scripting) (or as PDF) 

 C++ Api documentation 

 PyQGIS - QGIS Python Api documentation 

                                                           
41 https://www.qgis.org/en/docs/index.html 

http://docs.qgis.org/3.10/en/docs/documentation_guidelines
http://docs.qgis.org/3.10/en/docs/pyqgis_developer_cookbook/
https://qgis.org/api/3.10/
https://qgis.org/pyqgis/3.10/
http://docs.qgis.org/testing
http://docs.qgis.org/testing/en/docs/user_manual
http://docs.qgis.org/testing/en/docs/training_manual/
http://docs.qgis.org/testing/en/docs/pyqgis_developer_cookbook
http://docs.qgis.org/testing/en/docs/developers_guide
https://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html
http://docs.qgis.org/testing/en/docs/documentation_guidelines
http://docs.qgis.org/testing/en/docs/gentle_gis_introduction/
http://docs.qgis.org/testing/pdf
https://qgis.org/api/
https://qgis.org/pyqgis/master/
http://docs.qgis.org/3.4/en/docs/user_manual
http://docs.qgis.org/3.4/pdf/en/QGIS-3.4-UserGuide-en.pdf
http://docs.qgis.org/3.4/en/docs/training_manual/
http://docs.qgis.org/3.4/pdf/en/QGIS-3.4-QGISTrainingManual-en.pdf
http://docs.qgis.org/3.4/en/docs/gentle_gis_introduction
http://docs.qgis.org/3.4/en/docs/documentation_guidelines
http://docs.qgis.org/3.4/en/docs/pyqgis_developer_cookbook/
http://docs.qgis.org/3.4/pdf/en/QGIS-3.4-PyQGISDeveloperCookbook-en.pdf
https://qgis.org/api/3.4/
https://qgis.org/pyqgis/3.4/
https://www.qgis.org/en/docs/index.html
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QGIS Tutorials and Tips 

For extraordinary Guides and Documentation, refer to the Official Page of QGIS Project.[42]. Thanks to the 

Community, several docs, guide, tutorial and video are available on the Net: 

 “Documentation for QGIS 3.10” [43] 

  “QGIS Training Manual”[44] 

 “Training Material”[45] 

 “A Gentle Introduction to GIS”[46] 

 QGIS Tutorials and Tips[47] 

 “Klas Karlsson QGIS Video”[48] 

 And many others… 

  

 

Figure 9 - Klas Karlsson QGIS You Tube Channel 

  

                                                           
42 https://www.qgis.org/en/site/ 

43 https://docs.qgis.org/3.10/en/docs/ 
44 https://docs.qgis.org/3.10/en/docs/training_manual/index.html 
45 qgis.org/en/site/forusers/trainingmaterial/index.html 
46 https://docs.qgis.org/3.10/en/docs/gentle_gis_introduction/index.html 
47 http://www.qgistutorials.com/en/index.html 

48 https://www.youtube.com/user/klakar70 

https://www.qgis.org/en/site/
https://docs.qgis.org/3.10/en/docs/
https://docs.qgis.org/3.10/en/docs/training_manual/index.html
https://docs.qgis.org/3.10/en/docs/gentle_gis_introduction/index.html
http://www.qgistutorials.com/en/index.html
https://www.youtube.com/user/klakar70
https://www.youtube.com/user/klakar70
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Where find GIS data? 

The better way to search, browse and download data is to use GOOGLE (or another search engine). For 

example: 

Search engine 

 

Figure 10 - Google Search for the GIS Data 

Broadly speaking, many sites that contains GIS data are following a sort of “common standardisation” by 

calling “GEOPORTAL”[49] their site. 

 

As we have seen befor, searching for geoportal will return 10.200.000 result in all over the world. Maybe it 

is better to limit the search procedure, insertiting other information, such as the name of the geographic 

region or the country. 

Advanced Search 
It is very easy to use Google for searching a particular kind of data. For example, if we need to get data in PDF 

format try using the following syntax: 

The results will talk by themselves: all the results of cultural+heritage will be in PDF file format only. Text 

between quotes is the “search string” while the “extension” (filetype:pdf is an option) allows to search for a 

particular subset kind of formats. 

                                                           
49 A geoportal is a type of web portal used to find and access geographic information and associated geographic services via the Internet. Geoportals are important for effective use 

of geographic information systems and a key element of Spatial Data Infrastructure. Wikipedia 

https://en.wikipedia.org/wiki/Geoportal
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“Filetype” option is obviously valid for the most common file format (DOC, DOCX, XLS, XLSX, PPT, PPTX…, 

PDF…) but do not allows (of course) to search MP3, AVI… files. But, we can say, it is very “hard” to use a PDF 

file into a MAP… 

This is why is better to try other extension, such as SHP (that stands for Shapefile) or, better, CSV (that stand 

for Comma Separated Value)[50]. 

So, following the guide[51] If we are searching for “Geoportal” we should use the  allintitle:geoportal and/or 
allinurl:geoportal option: 

 

For best results, remberb to switch on the Google search language from the local default to “english” (or 

other language)[52]. 

Not only “Geoportal” but also “Open Data” portal may share (geographic) information. 

Open Data 
“Open data is data that anyone can access, use and share. Governments, businesses and individuals can use 

open data to bring about social, economic and environmental benefits”[53]. 

                                                           
50 https://en.wikipedia.org/wiki/Comma-separated_values 
51 https://ahrefs.com/blog/google-advanced-search-operators/ 
52 https://support.google.com/customsearch/answer/2633296?hl=en 
53 https://www.europeandataportal.eu/elearning/en/module1/#/id/co-01 

https://en.wikipedia.org/wiki/Comma-separated_values
https://ahrefs.com/blog/google-advanced-search-operators/
https://support.google.com/customsearch/answer/2633296?hl=en
https://www.europeandataportal.eu/elearning/en/module1/#/id/co-01
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The European Data Portal says[54]:  

 “Data is open if anyone can access, use and share it. 

 “Open data becomes usable when made available in a common, machine-readable format.” 

 “Open data must be licensed. Its licence must permit people to use the data in any way they want, 

including transforming, combining and sharing it with others, even commercially.” 

And, again: 

“There are some simple things to consider when defining openness:” 

“LIMITATIONS” 

 “For data to be open, it should have no limitations that prevent it from being used in any particular 

way 

 Anyone should be free to use, modify, combine and share the data, even commercially” 

“COST” 

 “Open data must be free to use, but this does not mean that it must be free to access. 

 There is often a cost to creating, maintaining and publishing usable data. 

 Ideally, any fee for accessing open data should be no more than the reasonable reproduction cost of 

the unit of data that is requested. 

 This reproduction cost tends to be negligible for many datasets. 

 Live data and big data can incur ongoing costs related to reliable service provision”. 

“REUSE” 

 “Once the user has the data, they are free to use, reuse and redistribute it – even commercially. 

 Open data is measured by what it can be used for, not by how it is made available. 

 Aspects like format, structure and machine readability all make data more usable, and should all be 

carefully considered. 

 However, these do not make the data more open”. 

 

Figura 1 - European Data Portal 

                                                           
54 https://www.europeandataportal.eu/elearning/en/module1/#/id/co-01 

https://www.europeandataportal.eu/elearning/en/module1/#/id/co-01
https://www.europeandataportal.eu/elearning/en/module1/#/id/co-01
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Figura 2 - Map representation of Open Data Sites (Data.gov) 

 

 

Figura 3 - DATA.GOV 

 

Figura 4 - European Open Data Portal 

https://www.data.gov/open-gov/
https://www.data.gov/open-gov/
https://data.europa.eu/euodp/en/home
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Figura 5 - Data Portals 

So, take into account these suggestions also and browse with patience! 

  

https://dataportals.org/
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GIS data 

In a GIS system we can use vector data, raster data or even tabular data to store and manage geographic 

information. To use Vector data we have to think about geometry: points, polylines and polygons are the 

geometric primitives that help us to describe the real world. 

 

Figure 11 - From Real World to GIS Layers 

Depend on the scale we can use a point to identify an hospital (a public phone, a traffic light); a polyline to 

describe a river (a road); a polygon to show an hospital (a road, a river) and so on. Raster data are 

(georeferred) images and the resolution depend on the pixel width. Tabular data may contain addresses (it 

is possible to transform them into points using a “geocoding” tool). 

 

Figure 12 – Vector Layer: the Geometries 

Vector data are commonly stored and shared into a file format called “Shapefile” (but maybe we could find 

the same data into “Geopackage”, “Geodatabase” and other GIS formats). 

Raster data are images (TIF, JPG…) that are correctly “positioned” on the map by using an auxiliary file (TFW, 

JGW…). 

Real World 

https://www.nationalgeographic.org/encyclopedia/geographic-information-system-gis/
https://www.edc.uri.edu/nrs/classes/NRS409509/Lectures/3GISdefined/Carto.png
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Raster resolution is based on pixel depth.  

 

Figure 13 - Raster Layer: the Pixel 

Not only the pixel size can influence the image quality resolution (small pixel means very good image even if 

the size of the file “increase”) but also the “colour depht”[55] could You save or not disk space. 

 

Figure 14 - Vector Model, Raster Model 

Tabular data, instead, could be a simple text file. Commonly is useda Comma Separated Value (CSV) format. 

All of these file format will be described later. 

Vector data 

Shapefile 

The shapefile format is a (one of the most common) “geospatial vector data format for geographic 

information system (GIS) software. It is developed and regulated by Esri as a mostly open specification for 

data interoperability among Esri and other GIS software products.[56] The shapefile format can spatially 

describe vector features: points, lines, and polygons, representing, for example, water wells, rivers, and lakes. 

Each item usually has attributes that describe it, such as name or temperature”.[57] 

Each Shapefile can store and manage only one kind of “geometric data”. It is not possible to “merge” points, 

polylines and/polygons togheter. If we need to store a variety of data we have to use several shapefiles, one 

for each kind of geometric data. 

                                                           
55 https://en.wikipedia.org/wiki/Color_depth 
56 ESRI (July 1998). "ESRI Shapefile Technical Description", http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf 

57 https://en.wikipedia.org/wiki/Shapefile 

https://en.wikipedia.org/wiki/Color_depth
https://www.edc.uri.edu/nrs/classes/NRS409509/Lectures/3GISdefined/Cartopixels.png
http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture05/concepts/03%20-%20Geographic%20data%20models_files/image003.gif
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Figure 15 - Vector Model 

Shapefile examples: {rivers.shp, rivers.shx, rivers.dbf} plus {rivers.prj (ESRI) or rivers.qpj (QGIS)} 

Mandatory files  

 

.shp — shape format; the feature geometry itself {content-type: x-gis/x-shapefile} 

.shx — shape index format; a positional index of the feature geometry to allow seeking forwards and 

backwards quickly {content-type: x-gis/x-shapefile} 

.dbf — attribute format; columnar attributes for each shape, in dBase IV format {content-type: 

application/octet-stream OR text/plain} 

 

Other files  

 

.prj — projection description, using a well-known text representation of coordinate reference 

systems {content-type: text/plain OR application/text}. QGIS use a .qpj file also. 

.sbn and .sbx — a spatial index of the features {content-type: x-gis/x-shapefile} 

.fbn and .fbx — a spatial index of the features that are read-only {content-type: x-gis/x-shapefile} 

.ain and .aih — an attribute index of the active fields in a table {content-type: x-gis/x-shapefile} 

.ixs — a geocoding index for read-write datasets {content-type: x-gis/x-shapefile} 

.mxs — a geocoding index for read-write datasets (ODB format) {content-type: x-gis/x-shapefile} 

.atx — an attribute index for the .dbf file in the form of shapefile.columnname.atx (ArcGIS 8 and later) 

{content-type: x-gis/x-shapefile} 

.shp.xml — geospatial metadata in XML format, such as ISO 19115 or other XML schema {content-

type: application/fgdc+xml} 

.cpg — used to specify the code page (only for .dbf) for identifying the character encoding to be used 

{content-type: text/plain OR x-gis/x-shapefile} 

http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture05/concepts/03%20-%20Geographic%20data%20models.html
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.qix — an alternative quadtree spatial index used by MapServer and GDAL/OGR software {content-

type: x-gis/x-shapefile} 

In each of the .shp, .shx, and .dbf files, the shapes in each file correspond to each other in sequence (i.e., the 

first record in the .shp file corresponds to the first record in the .shx and .dbf files, etc.). The .shp and .shx 

files have various fields with different endianness, so an implementer of the file formats must be very careful 

to respect the endianness of each field and treat it properly. 

The shapefile format does not have the ability to store topological information.[58] 

In general, each geometry links to an attribute (record) that is stored into the DataBase File (DBF): 

 

Figure 16 - How Shapefile "Works" 

Raster data 

“In the raster data model, the earth is represented as a grid of equally sized cells. An individual cell represents 

a portion of the earth such as a square meter or a square mile.  

Unlike the vector data model, where x,y coordinates are used to define feature shapes and locations, in the 

raster data model, only one x,y coordinate pair is normally present. This x,y coordinate pair (called the origin) 

is used to define the location of every cell. That is, each cell's location is defined in relation to the origin.  

Each raster cell is assigned a numeric value, which can represent any kind of information about that 

geographic location—an elevation measurement in meters, for example, or a code number that specifies a 

type of vegetation”.[59] 

                                                           
58 https://en.wikipedia.org/wiki/Shapefile 
59 http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture05/concepts/03%20-%20Geographic%20data%20models.html 

https://transportgeography.org/?page_id=7636
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Figure 17 - Raster Model 

Image format 

Broadly speaking, images could be in TIF or JPG (…) format but we have to manage their “position” into the 

space. This is because, without any other information, the images will placed in the center of the screen 

(think about what happen when we use an Image Software like GIMP, Paint, Adobe Photoshop or other ones). 

So, we need auxiliary data or files that tell to the software where place the image. This file are called “world 

file”[60] and these are some examples of file format with related “sidecar file”: 

 TIF image need a TFW file 

 JPG image need a JGW file 

 PNG image ned a PGW file 

 SID[61] image need a SDW file 

“For example, “a world file (is) a 6-line ASCII file file such as: 

                   2.4384 

                   0.0000 

                   0.0000 

                  -2.4384 

              441794.4342 

             5094101.4520 

 

“These are the 6 coefficients of a three-by-three transformation matrix. They indicate that a pixel is 2.4384 
meters square, and that the center of the upper left pixel has an easting (x coordinate) of 441794.4342 and 
a northing of 5094101.4520. For fans of the matrix: 

x = 2.4384 * column + 0.0 * row + 441794.4342 

y = (-2.4384) * row + 0.0 * column + 5094101.4520 

The second and third values are zero because there is no rotation or skew”. 

                                                           
60 https://en.wikipedia.org/wiki/World_file 
61 MrSID (Multi-resolution Seamless Image Database) is a patented, wavelet-based file format designed to enable portability of massive bit-mapped (raster) images. The format was 

designed to enable instantaneous viewing and manipulation of large imagery both locally and over networks without sacrificing quality. Created by LizardTech, MrSID works by 

putting together hundreds of small image tiles into one large seamless image that can be compressed and decompressed with little or no degradation (https://kb.iu.edu/d/atbf). 

https://en.wikipedia.org/wiki/World_file
https://kb.iu.edu/d/atbf
http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/lecture05/concepts/03%20-%20Geographic%20data%20models.html
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“The convention is that a world file is named by jamming a «w» into the extension. For example, 
o47122d3.jpg might have a o47122d3.jgw file and o47122d3.tif might have a o47122d3.tfw file”[62]. 

After loading a “section” the corrisponding image will placed into the “correct space” using the appropriate 
world file. 

 

Figure 18 - Raster "Mosaic" 

The coloured box to display only the single section only and there are not other messages. 

Other images do not need of the “sidecar file” because they are capable to store inside the information about 
their georeferencing. These images should be, for example, “GeoTIFF”. “GeoTIFF is a public domain metadata 
standard which allows georeferencing information to be embedded within a TIFF file. The potential 
additional information includes map projection, coordinate systems, ellipsoids, datums, and everything else 
necessary to establish the exact spatial reference for the file. The GeoTIFF format is fully compliant with TIFF 
6.0, so software incapable of reading and interpreting the specialized metadata will still be able to open a 
GeoTIFF format file”.[63] 

  

                                                           
62 http://gis.ess.washington.edu/data/raster/drg/tfw.html 

63 https://en.wikipedia.org/wiki/GeoTIFF 

https://en.wikipedia.org/wiki/Public_domain
https://en.wikipedia.org/wiki/Metadata_(computing)
https://en.wikipedia.org/wiki/Georeference
https://en.wikipedia.org/wiki/TIFF
https://en.wikipedia.org/wiki/Map_projection
https://en.wikipedia.org/wiki/Coordinate_system
https://en.wikipedia.org/wiki/Ellipsoid
https://en.wikipedia.org/wiki/Datum_(geodesy)
http://gis.ess.washington.edu/data/raster/drg/tfw.html
https://en.wikipedia.org/wiki/GeoTIFF
http://www.qgistutorials.com/en/docs/3/raster_mosaicing_and_clipping.html
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QGIS Graphic User Interface (GUI) 

This not the place to describe ALL the buttons and the functionalities of QGIS. Nevertheless, it is appropiate 

to give You a “panorama” of the QGIS GUI and the links to the reference guide[64]. Before caming, just a 

note about the language in use. 

Use a different language 
QGIS lets us to set up and use a different language or settings about numbers, date and currency format. 

Go to Settings ‣ Options ‣General  

 

Figure 19 - QGIS GUI -  Change the Language 

Nowadays, thanks to a great voluntary participation, there are 39 languages ready to use: 

                                                           
64 https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html 

https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html
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Figure 20 - QGIS GUI - Choose a Language 

By the way, I prefer the English language. This is because many suggestions, video or tutorial are released in 

the English language. However, feel free to choose the language you like. 

After modifying the language in use it is mandatory close QGIS and restart it to use the new language. 

Now, we are ready to explore the GUI: 

 

Figure 21 - QGIS GUI 

In this image we can recognise: 

Menu Bar (1); Toolbars (2); Panels (3); Map View (4) Status Bar (5) 

The “Menu Bar” contains several menu: Project, Edit, View, Layer, Settings, Plugins, Vector, Raster, Database, 

Web, Mesh, Processing, Help. 

Toolbars and Panels contain the software “tools” and the “space” in which is possibile to display, to perform 

an action, to give or get “information” 

Map View is the “canvas” in which the data are displayed. Take a tour about “Exploring the map view” and 

“Exporting the map view” 

3D visualization support is avalaible through the 3D map view in which there are a Scene Configuration and 

info about 3D vector layers. 

https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#label-menubar
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#sec-panels-and-toolbars
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#sec-panels-and-toolbars
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#label-mapview
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#label-statusbar
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#label-menubar
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#project
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#edit
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#view
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#layer
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#settings
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#plugins
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#vector
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#raster
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#database
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#web
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#mesh
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#processing
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#help
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#toolbars
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#panels
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#map-view
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#exploring-the-map-view
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#exporting-the-map-view
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#d-map-view
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#scene-configuration
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#d-vector-layers
https://docs.qgis.org/3.10/en/_images/startup.png
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Last but not least, the Status Bar “provides you with general information about the map view and processed 

or available actions, and offers you tools to manage the map view”.[65] 

 

  

                                                           
65 https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#d-vector-layers 

https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#status-bar
https://docs.qgis.org/3.10/en/docs/user_manual/introduction/qgis_gui.html#d-vector-layers
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In other words, to semplify: 

 

Figure 22 - QGIS GUI by Baloons 

What kind of data can I use into QGIS? 

 

In QGIS software we’ll be able to use a great variety of data: 

 
Shapefiles… 

 
Tiff Images… 

 
Comma Separated Values (CSV)  

 
Load data from PostgreeSQL/PostGIS database 

 
Load data from SpatiaLite database 

 
Load data from MS-SQL database 

 
Load data from DB2 databse 

 
Load data from Oracle Spatial database 

 
Virtual Layer 

 
OGC Web Map Service / Web Map Tile Services 

 
ESRI ArcGIS Map Server  

 
OGC Web Coverage Service  

 
Web Feature Service 

Button Bar 
Menu Bar 

Data 

Browser 

Layer List 

Coordinate 

Type  
Coordinate 

Value Scale 

Map Area  
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ESRI ArcGIS Feature Server 

Table 3 - GIS Layers 

The highlighted format will be used in this tutorial. 

By opening a «Add a Vector Layer» Layer ‣ Add Layer… ‣ Add Vector Layer… we’ll see a variety of 

formats (looks “how long” is the scroll bar in the following dialog): 

 

Figure 23 - Vector  Formats 

By opening «Add a Raster Layer» menu we’ll see a variety of formats (looks “how long”is the scroll bar in the 

following dialog): 

 

Figure 24 - Raster Formats 
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The QGIS “compatibility list” is very wide and this represent a powerful input. To get some ideas about GIS 

format take a look of “The Ultimate List of GIS Formats and Geospatial File Extensions”[66]. 

Add a Shapefile to QGIS 

Befort starting we have to feed our software searching for appropriate GIS data. Maybe, considering the 

goals of this Master should be useful starting from the Humanitarian Data Exchange (HDX)[67] site: 

 

Figure 25 - The Humanitarian Data Exchange (HDX) #1 

we could search for “heritage” string: 

 

Figure 26 - The Humanitarian Data Exchange (HDX) #2 

The first “answer” could be: 

                                                           
66 https://gisgeography.com/gis-formats/ 
67 https://data.humdata.org/ 

https://gisgeography.com/gis-formats/
https://data.humdata.org/
https://data.humdata.org/
https://data.humdata.org/
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Syria Cultural Sites[68][69] 

U.S. Department of State - Humanitarian Information Unit 

200+ Downloads 

Updated November 1, 2019 | Dataset date: May 1, 2013 

This dataset updates: Every month 

 

The Syria Cultural Sites dataset contains geographic location (point geometry), name, type, and 

area name of over 1000 cultural heritage sites and museums in Syria compiled by the Cultural 

Heritage Center, Bureau of Educational and Cultural Affairs, U.S. Department of State 

(http://eca.state.gov/cultural-heritage-center) as of Spring 2013. The sites are categorized by type, 

which include but not limited to, archaeological sites, roman ruins, mosques, schools, churches, 

cemeteries, and towns. The data contained herein is entirely unclassified. 

 

Figure 27 - HDX Download Data 

  

Choose the first one (Syria_CulturalSites_2013May22_HIU_USDoS.zip) and download and decompress it 
into an appropriate folder. To get more information it is mandatory to read the related “Metadata”: 

 

Source: U.S. Department of State 

Contributor: U.S. Department of State - Humanitarian Information Unit 

Date of Dataset: May 01, 2013 

Updated: November 1, 2019 

Expected Update Frequency: Every month 

Location: Syrian Arab Republic 

Visibility: Public 

License: Public Domain / No Restrictions 

                                                           
68 https://data.humdata.org/search?q=heritage&ext_search_source=main-nav 

69 https://data.humdata.org/dataset/syria-cultural-sites 

https://data.humdata.org/dataset/syria-cultural-sites
https://data.humdata.org/organization/us-state-hiu?sort=metadata_modified+desc
http://eca.state.gov/cultural-heritage-center
https://data.humdata.org/search?q=heritage&ext_search_source=main-nav
https://data.humdata.org/dataset/syria-cultural-sites
https://data.humdata.org/dataset/syria-cultural-sites
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Methodology: Other 

Caveats / Comments: All data are strictly unclassified with no restrictions on distribution. Accuracy 
of geographic data is not assured by the U.S. Department of State. All data elements extracted from 
source data listed in the abstract. 

Tags: CULTURAL SITES; EDUCATION; EDUCATION FACILITIES–SCHOOLS; GEODATA 

File Format: ZIPPED SHAPEFILE, GEOJSON, KML, XML 

Method 1 – Drag&Drop 

Start QGIS and place the Sofware window next to the Windows File Explorer. Search for 
Syria_CulturalSites_2013May22_HIU_USDoS.shp. Then Drag-and-Drop it until the QGIS Map Area and 
release the mouse button: 

 

 

Figure 28 - Add Vector Layer #1 

 

The result of this operation will displayed in the QGIS Map Area: 

 

Figure 29 - Add Vector Layer #1a 

Map Area  

Map Area  
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Method 2 – Data Source Manager (Button) 

Search for the Data Sorce Manager Button and click on it. 

 

Figure 30 - Add Add Vector Layer #2 

Choose “Vector” (shapefile is a “vector container”): 

 

Figure 31 - Add Vector Layer #2a 

Then, Browse the Source Vector Dataset: 
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Figure 32 - Add Vector Layer #2b 

Search for the data You desire to load and select it. To improve the searching procedure, could be useful to 

set the data filetype on: ESRI Shapefile. 

 

 

Figure 33 - Add Vector Layer #2c 

Method 3 – Data Browser (Window) 

Search for the Data Browser. Open the appropriate folder and search for the data.  
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Figure 34 - Add Shapefile #3 

 

Search for Syria_CulturalSites_2013May22_HIU_USDoS.shp. Then Drag-and-Drop it until the QGIS Map Area 
and release the mouse button. 

Method 4 – Add Layer (Menu) 

From the Menu Bar, search for “Layer”, “Add Layer”, “Add Vector Layer” 

 

Figure 35 - Add Vector Layer #4 

As done previously, browse folders and data, look for the shapefile and load it using the usual series of 

dialogs. 

Method 5 – Use a “shortcut” 

Last but not least, it is possibile to use a "keyboard combination” to “Add shapefile”. The shortcut is: Control 

(CTRL) + Shift (↑) + “V”. The dialog “Data Source Manager | Vector”will appear and - as done previously - 

browse folders and data, look for the shapefile and load it using the usual series of dialogs. 
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Figure 36 - Add Vector Layer #5 

 

Moving on the map 

The point layer containg the geographic location of the Cultural Sites of Syria. After loading the shapefile into 

the canvas the points will be dispalyed on the map. 

To have interactions with the mapi t is possibile use the “Map Navigation Toolbar” 

 

Figure 37 - Moving on the Map 

The meaning of the buttons is intuitive. You can try without any problem (no modification will be 

performed on the data). 

QGIS Attribute Table 

On the layer name, a right click of the mouse will displayed a contestual menu. Choose the “Open Attribute 

Table”: 

 

Figure 38 - Open Attribute Table 

 

The attribute table (the data that are stored into the “Shapefile” or, better, into the *.DBF file of the 

Shapefile) will be displayed. 
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Figure 39 - The Attribute Table 

On the “Title bar”, QGIS give us some extra details. The name of the Layer from which derived, the feature 

number: “Total”, “Filtered” and “Selected”. “Total” means: in this layer there are 1061 points; “Filtered” 

means that we haven’t performed any filtering on data (the value is zero); “Selected” means that we 

haven’t performed any selection on data (the value is zero). 

Look at the table. In this case, each point corresponds to a ROW (a RECORD) into the table. Looking at the 

buttons and try to remember the “meanings”. 

On the bottom left there is a menu that allows to manage and apply a “dynamic filter” to data: 

 

Figure 40 - The Attribute Table - Show all -features (or the Selected Feature or...) 

Try it (if You do not have geometries or records selected the second filter will operate not). 

On the bottom right there are two button that will switch the table display from “table wiew” to “form view” 

and viceversa: 

 

Figure 41 - The Attribute Table - "Table View" or "Formi View" 
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Try them. 

Build a thematic map 

When You load a vector data (containing points, polylines or polygoins, never mind) all the geometries will 

be drawn usin the same colour (same outline, same fill). In general, this representation of data does not help 

the reader. 

The colour is “random”: this mean that QGIS has not an Artifical Intellicence (AI) capable to display the rivers 

in blue or the road in grey… 

Imagine that we would display the information based on the data (the attribute data) that the Shapefile 

Creator has stored inside the geometries. 

The “Layer Properties” 

As seen before, a right click of the mouse on the layer name will displayed a contestual menu. Choose the 

“Properties…”(that means: the layer properties): 

 

 

Figure 42 - Vector Layer - Properties 

 

A new dialog will appear. Take a look on the single tab: 

Information; Source; Symbology; Labels; Diagrams; 3D View; Source Fields; Attribute fields; Joins; Auxiliary 

Storage; Actions; Display; Rendering; Variables; Metadata; Dependencies; Legend 

The detail is complete and these properties let You know all the necessary information about the layer and 

the relating settings (that we are able to modify also). 



                                                                                 A short intro to FLOSS, GIS, and QGIS 

 

Figure 43 - The Layer Properties 

Click on “Simbology”. This menu let us to change the way in which the data is displayed. By default, the 

data use a “Single symbol” (that means: all the geometries will be displayed using a singol colour/style). 

 

Figure 44 - The Layer Properties – Symbology – Single Symbol #1 

Click on the pull down menu and look at the values: 

 

Figure 45 - The Layer Properties – Symbology Single Symbol #2 

To display “Categories” perhaps we need of the “Categorized” option (while if we would operate with 

numeric values we have to choose the following one, “Gratuated”). 

Choose the “Categorized” option: 
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Figure 46 - The Layer Properties - Symbology - Categorized#1 

The dialog is a white blackboard: this means that we have to give some input to QGIS in order to perform 

some operations. Do You remeber what the table contains? 

 

Figure 47 - Attribute Data 

It is not useful to distinguish the name of the site (each site has a different name…) but should be great to 

“group by” the value using a description (“FAC_DES” field or “CLASS” instead).  

Choose the FAC_DES field (on the left of the column name QGIS will show the kind of data: abc meand thet 

the field contain text; 123 if the field contains number…): 
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Figure 48 - The Layer Properties - Symbology - Categorized#2 

and select “Classify” button: 



                                                                                 A short intro to FLOSS, GIS, and QGIS 

 

Figure 49 - The Layer Properties - Symbology - Categorized#3 

This thematic representation is not wery useful because the “DESCRIPTION” is not so strict… In the map a 

variety of colour will displayed and the User will no be able to read in a correct way the representation of the 

data. 

 

Figure 50 - The Layer Properties - Symbology - Categorized#4 
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In this case, maybe, is better to change the field to another one, “CLASS” for example. 

 

Figure 51 - The Layer Properties - Symbology - Categorized#5 

This is a great result! Now it is possible to change the symbols, the colours an the “Legend” value. Try it and 

at the end of the exercise remember to “Apply” and close the dialog in order to see the updating map! 

Last, but not least, if You have found a good data representation, why don’t You save Your style? Under the 

Style pull down menu: 

 

Figure 52 - The Layer Properties - Symbology - Categorized#6 

try to save the Style You have just created.  

Add a Raster to QGIS 

We can use the same HDX site to search for a raster dataset. 

 Mozambique Drought  

 OCHA Mozambique HAT  
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 30+ Downloads  

 Updated April 12, 2019 | Dataset date: Apr 12, 2019  

 This dataset updates: Never 

 Data produced under the ADRF Sub Saharan Africa Risk Profiles project. The project provides also 

risk data produced, exposure and hazard data used in the analyses. 

 

Figure 53 - Download Raster 

Method 1 – Drag&Drop 

Start QGIS and place the Sofware window next to the Windows File Explorer. Search for 
euwatch_spi_mozambique_r25_30s_clipped.tif. Then Drag-and-Drop it until the QGIS Map Area and release 
the mouse button: 

 

 

Figure 54 - Add Raster Layer #1a 

 

The result of this operation will be displayed in the QGIS Map Area: 

https://data.humdata.org/dataset/mozambique-drought
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Figure 55 - Add Raster Layer #1b 

The “pixel” are “coloured” because of the precence, in the same folder of the data, of another file, 

euwatch_spi_mozambique_r25_30s_clipped.qml. This file contains style information and therefore can 

assign a “predefined legend style” to a raster layer also. 

Method 2 – Data Source Manager (Button) 

Search for the Data Sorce Manager Button and click on it. 

 

Figure 56 - Add Raster Layer #2a 

Choose “Raster” (TIFF is a “raster container”): 

Map Area  
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Figure 57 - Add Raster Layer #2b 

Then, Browse the Source Raster Dataset: 

  

Figure 58 - Add Raster Layer #2c 

Search for the data You desire to load and select it. To improve the searching procedure, could be useful to 

set the data filetype on: GeoTIFF Images. 
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Figure 59 - Add Raster Layer #2d 

Method 3 – Data Browser (Window) 

Search for the Data Browser. Open the appropriate folder and search for the data.  

 

 

 

 

Figure 60 - Add Raster Layer #3 

 

Search for euwatch_spi_mozambique_r25_30s_clipped.tif. Then Drag-and-Drop it until the QGIS Map Area 
and release the mouse button. 

Method 4 – Add Layer (Menu) 

From the Menu Bar, search for “Layer”, “Add Layer”, “Add Raster Layer” 
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Figure 61 - Add Raster Layer #4 

As done previously, browse folders and data, look for the image and load it using the usual series of dialogs. 

Method 5 – Use a “shortcut” 

Last but not least, it is possibile to use a "keyboard combination” to “Add shapefile”. The shortcut is: Control 

(CTRL) + Shift (↑) + “R”. The dialog “Data Source Manager | Raster”will appear and - as done previously - 

browse folders and data, look for the shapefile and load it using the usual series of dialogs. 

 

Figure 62 - Add Raster Layer #5 

Open Geospatial Consortium (OGC) Services 

“The Open Geospatial Consortium (OGC), an international voluntary consensus standards organization, 

originated in 1994. In the OGC, more than 500 commercial, governmental, nonprofit and research 

organizations worldwide collaborate in a consensus process encouraging development and implementation 

of open standards for geospatial content and services, sensor web and Internet of Things, GIS data 

processing and data sharing”.[70] 

The OGC standards baseline comprises more than 30 standards71, including, among the others: 

 CSW – Catalog Service for the Web: access to catalog information 

                                                           
70 https://en.wikipedia.org/wiki/Open_Geospatial_Consortium 

71 https://www.ogc.org/standards/ 

https://en.wikipedia.org/wiki/Standards_organization
https://en.wikipedia.org/wiki/Geospatial
https://en.wikipedia.org/wiki/Internet_of_Things
https://en.wikipedia.org/wiki/Geographic_information_system
https://en.wikipedia.org/wiki/Data_processing
https://en.wikipedia.org/wiki/Data_processing
https://en.wikipedia.org/wiki/Data_sharing
https://en.wikipedia.org/wiki/Open_Geospatial_Consortium
https://www.ogc.org/standards/
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 GML– Geography Markup Language: XML-format for geographical information 

 KML – Keyhole Markup Language: XML-based language schema for expressing geographic 

annotation and visualization on existing (or future) Web-based, two-dimensional maps and three-

dimensional Earth browsers 

 SLD - Styled Layer Descriptor 

 SRID, an identification for spatial coordinate systems 

 WCS – Web Coverage Service: provides access, subsetting, and processing on coverage objects 

 WFS – Web Feature Service: for retrieving or altering feature descriptions 

 WMS – Web Map Service: provides map images 

 WMTS – Web Map Tile Service: provides map image tiles 

 WPS – Web Processing Service: remote processing service 

 WTS – Web Terrain Service (WTS) 

We’ll use WMS (WMTS), WCS and WFS services and, if applicable, CSW. 

How add a Service using QGIS 

First of all we need a “service”. We can search for them usign “Google” but, as an example, we could use 

the Humanitarian Data Exchange (HDX) site[72]. 

 

Figure 63 - The Humanitarian Data Exchange Site - WMS Services #1 

Searching hor “WMS”… 

                                                           
72 https://data.humdata.org/ 

https://data.humdata.org/
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Figure 64 - The Humanitarian Data Exchange Site - WMS Services #2 

Browse the result list: 

 

Figure 65 - The Humanitarian Data Exchange Site - WMS Services #3 

until find the section containg “service” or “server” string: 

 

Figure 66 - The Humanitarian Data Exchange Site - WMS Services #4 

A “Map Server” is a WMS and the nit is possibile toload it, as “basemap”, into QGIS. Press the button 

“Download”. In this case, a new page will be displayed: 

https://data.humdata.org/dataset/lebanon-administrative-boundaries-levels-0-3
https://data.humdata.org/dataset/lebanon-administrative-boundaries-levels-0-3
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Figure 67 - ArcGIS REST Services Directory #1 

Search in the page for “WMS”: 

 

Figure 68 - ArcGIS REST Services Directory #2 

and click onthe hypelink. An XML file will appear on the screen: 

 

Figure 69 - WMS (XML) #1 

 

Inside the text, search for an internet address, such as: 

https://gistmaps.itos.uga.edu/arcgis/rest/services/COD_External/LBN_AR/MapServer
https://gistmaps.itos.uga.edu/arcgis/rest/services/COD_External/LBN_AR/MapServer
https://gistmaps.itos.uga.edu/arcgis/services/COD_External/LBN_AR/MapServer/WMSServer?request=GetCapabilities&service=WMS
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Figure 70 - WMS (XML) #2 

Copy the address (without quotes). Open QGIS and look for the “Browser” panel, in particular, the section 

containing “Services”: 

 

Figure 71 - OGC Services and Other Connections 

Look for WMS/WMTS and, with a right cick of the mouse, create a “New connection”: 

 

 

Figure 72 – WMS / WMTS Services - New Connection... 

A “Create a New WMS/WMTS Connection” dialog will appear: 

https://gistmaps.itos.uga.edu/arcgis/services/COD_External/LBN_AR/MapServer/WMSServer?request=GetCapabilities&service=WMS
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Figure 73 - Create a New WMS/WMTS Connection #1 

In the “Connection Details” 

 Name = insert a name You like 

 URL = paste the address found before[73]  

 

 

Figure 74 - Create a New WMS/WMTS Connection #2 

And presso “OK”. Go back to the “Browser” and search for the name You have assigned to the connection. 

                                                           
73 https://gistmaps.itos.uga.edu/arcgis/services/COD_External/LBN_AR/MapServer/WmsServer? 
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Figure 75 - New WMS/WMTS Layers #1 

 

Click on the > sign to explode the connection details until the layer list is visible: 

 

Figure 76 - New WMS/WMTS Layers #2 

A simple double click of the mouse on the layer name will load the related data into the map space. 
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Figure 77 - WMS/WMTS Display 

By using “services” no data will be downloaded or, better, the data displayed cames from the net (in this 

case, as a background map without the possibility of modify or change data). 

Maybe, all that we have seen now, is a “complex example”. In many other cases, searching for “OGC Services” 

it is very easy to find resources “ready-to-use”.For example, using Google Searching Engine it is possible to 

find, among the other, the “United Nations Clear Map”[74]. 

 

Figure 78 - United Nation Clear Map #1 

“Here you can find various versions of Clear Map and a guide on how to consume the clear map services in 

different platforms (ArcMap, ArcGIS Pro, QGIS, JavaScript API, Leaflet, Open Layers)”. 

“The United Nations Clear Map (hereinafter “Clear Map”) is a background reference web mapping service 

produced to facilitate “the issuance of any map at any duty station, including dissemination via public 

electronic networks such as Internet” and “to ensure that maps meet publication standards and that they 

are not in contravention of existing United Nations policies” in accordance with the in the Administrative 

Instruction on “Regulations for the Control and Limitation of Documentation – Guidelines for the Publication 

of Maps” of 20 January 1997[75]”. 

“Clear Map is created for the use of the United Nations Secretariat and community.  All departments, offices 

and regional commissions of the United Nations Secretariat including offices away from Headquarters using 

                                                           
74 https://geoportal.dfs.un.org/arcgis/home/item.html?id=541557fd0d4d42efb24449be614e6887 
75 http://undocs.org/ST/AI/189/Add.25/Rev.1 

https://geoportal.dfs.un.org/arcgis/home/item.html?id=541557fd0d4d42efb24449be614e6887
https://geoportal.dfs.un.org/arcgis/home/item.html?id=541557fd0d4d42efb24449be614e6887
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Clear Map remain bound to the instructions as contained in the Administrative Instruction and should 

therefore seek clearance from the UN Geospatial Information Section (formerly Cartographic Section) prior 

to the issuance of their thematic maps using Clear Map as background reference”.[76] 

In this site the links are clearly expressed: 

 

Figure 79 - United Nation Clear Map #2 

It is possible to find, on the net, many resources on OGC Services. Sometimes well find National or Loca 

Geoportals, other time could be happen to find list of resouces like this one: 

 

Figure 80 - GeoSeer - The Spatial Data Search Engine 

Or this one, based on CSW catalogues: 

 

 

Figure 81 - GEOPOLE - Search on CSW Catalogue 

 XYZ Tiles 

                                                           
76 https://geoportal.dfs.un.org/arcgis/home/item.html?id=541557fd0d4d42efb24449be614e6887 

https://geoportal.dfs.un.org/arcgis/home/item.html?id=541557fd0d4d42efb24449be614e6887
https://geoportal.dfs.un.org/arcgis/home/item.html?id=541557fd0d4d42efb24449be614e6887
https://www.geoseer.net/
http://geopole.org/
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“A tiled web map or tile map (raster or vector) is a map displayed in a browser by seamlessly joining dozens 
of individually requested image or vector data files over the internet. It is the most popular way to display 
and navigate maps, replacing other methods such as WMS which typically display a single large image. (…). 

There are several advantages to tiled maps. Each time the user pans, most of the tiles are still relevant, and 
can be kept displayed, while new tiles are fetched. This greatly improves the user experience, compared to 
fetching a single map image for the whole viewport. It also allows individual tiles to be pre-computed, a task 
easy to parallelize. Also, displaying rendered images served from a web server is less computationally 
demanding than rendering images in the browser, a benefit over technologies such as WFS”[77].  

How add Tile Server using a Phyton script 

Nowadays there are many tutorial and tile server providers[78][79][80] but using the QGIS Phyton Console 

(Plugin ‣ Python Console or press CTRL+ALT+P that is the QGIS shortcut) it is very easy to add, on-the-

fly, a variety of servers. 

The best resource is the following one[81][82]. All the code between «“””» and «“””» are «comments» and, a 
part the disclaimer, the license and the notes, it is possible to ignore while pasting it into QGIS. 

""" 

This script should be run from the Python consol inside QGIS. 

 

It adds online sources to the QGIS Browser. 

Each source should contain a list with the folowing items (string type): 

[sourcetype, title, authconfig, password, referer, url, username, zmax, zmin] 

 

You can add or remove sources from the sources section of the code. 

 

Script by Klas Karlsson 

Sources from https://qms.nextgis.com/ 

 

Licence GPL-3 

 

Regarding the terms of use for these background maps YOU will need to verify 

that you follow the individual EULA that comes with the different services, Most 

likely they will restrict how you can use the data. 

 

""" 

 

# Sources 

sources = [] 

                                                           
77 https://en.wikipedia.org/wiki/Tiled_web_map 
78 https://www.spatialbias.com/2018/02/qgis-3.0-xyz-tile-layers/ 
79 https://github.com/nextgis/quickmapservices 
80 https://github.com/nextgis/quickmapservices_contrib/tree/master/data_sources 
81 https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py 
82 https://twitter.com/klaskarlsson 

https://en.wikipedia.org/wiki/Web_Map_Service
https://en.wikipedia.org/wiki/Web_Feature_Service
https://en.wikipedia.org/wiki/Tiled_web_map
https://www.spatialbias.com/2018/02/qgis-3.0-xyz-tile-layers/
https://github.com/nextgis/quickmapservices
https://github.com/nextgis/quickmapservices_contrib/tree/master/data_sources
https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py
https://twitter.com/klaskarlsson
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sources.append(["connections-xyz","Google 

Maps","","","","https://mt1.google.com/vt/lyrs=m&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D",

"","19","0"]) 

sources.append(["connections-xyz","Google Satellite", "", "", "", 

"https://mt1.google.com/vt/lyrs=s&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D", "", "19", 

"0"]) 

sources.append(["connections-xyz","Google Terrain", "", "", "", 

"https://mt1.google.com/vt/lyrs=t&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D", "", "19", 

"0"]) 

sources.append(["connections-xyz","Google Terrain Hybrid", "", "", "", 

"https://mt1.google.com/vt/lyrs=p&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D", "", "19", 

"0"]) 

sources.append(["connections-xyz","Google Satellite Hybrid", "", "", "", 

"https://mt1.google.com/vt/lyrs=y&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D", "", "19", 

"0"]) 

sources.append(["connections-xyz","Stamen Terrain", "", "", "Map tiles by Stamen 

Design, under CC BY 3.0. Data by OpenStreetMap, under ODbL", 

"http://tile.stamen.com/terrain/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "20", "0"]) 

sources.append(["connections-xyz","Stamen Toner", "", "", "Map tiles by Stamen 

Design, under CC BY 3.0. Data by OpenStreetMap, under ODbL", 

"http://tile.stamen.com/toner/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "20", "0"]) 

sources.append(["connections-xyz","Stamen Toner Light", "", "", "Map tiles by 

Stamen Design, under CC BY 3.0. Data by OpenStreetMap, under ODbL", 

"http://tile.stamen.com/toner-lite/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "20", "0"]) 

sources.append(["connections-xyz","Stamen Watercolor", "", "", "Map tiles by 

Stamen Design, under CC BY 3.0. Data by OpenStreetMap, under ODbL", 

"http://tile.stamen.com/watercolor/%7Bz%7D/%7Bx%7D/%7By%7D.jpg", "", "18", "0"]) 

sources.append(["connections-xyz","Wikimedia Map", "", "", "OpenStreetMap 

contributors, under ODbL", "https://maps.wikimedia.org/osm-

intl/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "20", "1"]) 

sources.append(["connections-xyz","Wikimedia Hike Bike Map", "", "", 

"OpenStreetMap contributors, under ODbL", 

"http://tiles.wmflabs.org/hikebike/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "17", "1"]) 

sources.append(["connections-xyz","Esri Boundaries Places", "", "", "", 

"https://server.arcgisonline.com/ArcGIS/rest/services/Reference/World_Boundaries

_and_Places/MapServer/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "20", "0"]) 

sources.append(["connections-xyz","Esri Gray (dark)", "", "", "", 

"http://services.arcgisonline.com/ArcGIS/rest/services/Canvas/World_Dark_Gray_Ba

se/MapServer/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "16", "0"]) 

sources.append(["connections-xyz","Esri Gray (light)", "", "", "", 

"http://services.arcgisonline.com/ArcGIS/rest/services/Canvas/World_Light_Gray_B

ase/MapServer/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "16", "0"]) 

sources.append(["connections-xyz","Esri National Geographic", "", "", "", 

"http://services.arcgisonline.com/ArcGIS/rest/services/NatGeo_World_Map/MapServe

r/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "12", "0"]) 

sources.append(["connections-xyz","Esri Ocean", "", "", "", 

"https://services.arcgisonline.com/ArcGIS/rest/services/Ocean/World_Ocean_Base/M

apServer/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "10", "0"]) 

sources.append(["connections-xyz","Esri Satellite", "", "", "", 

"https://server.arcgisonline.com/ArcGIS/rest/services/World_Imagery/MapServer/ti

le/%7Bz%7D/%7By%7D/%7Bx%7D", "", "17", "0"]) 

sources.append(["connections-xyz","Esri Standard", "", "", "", 

"https://server.arcgisonline.com/ArcGIS/rest/services/World_Street_Map/MapServer

/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "17", "0"]) 
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sources.append(["connections-xyz","Esri Terrain", "", "", "", 

"https://server.arcgisonline.com/ArcGIS/rest/services/World_Terrain_Base/MapServ

er/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "13", "0"]) 

sources.append(["connections-xyz","Esri Transportation", "", "", "", 

"https://server.arcgisonline.com/ArcGIS/rest/services/Reference/World_Transporta

tion/MapServer/tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "20", "0"]) 

sources.append(["connections-xyz","Esri Topo World", "", "", "", 

"http://services.arcgisonline.com/ArcGIS/rest/services/World_Topo_Map/MapServer/

tile/%7Bz%7D/%7By%7D/%7Bx%7D", "", "20", "0"]) 

sources.append(["connections-xyz","OpenStreetMap Standard", "", "", 

"OpenStreetMap contributors, CC-BY-SA", 

"http://tile.openstreetmap.org/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "19", "0"]) 

sources.append(["connections-xyz","OpenStreetMap H.O.T.", "", "", "OpenStreetMap 

contributors, CC-BY-SA", 

"http://tile.openstreetmap.fr/hot/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "19", "0"]) 

sources.append(["connections-xyz","OpenStreetMap Monochrome", "", "", 

"OpenStreetMap contributors, CC-BY-SA", "http://tiles.wmflabs.org/bw-

mapnik/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "19", "0"]) 

sources.append(["connections-xyz","OpenTopoMap", "", "", "Kartendaten: © 

OpenStreetMap-Mitwirkende, SRTM | Kartendarstellung: © OpenTopoMap (CC-BY-SA)", 

"https://tile.opentopomap.org/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "17", "1"]) 

sources.append(["connections-xyz","Strava All", "", "", "OpenStreetMap 

contributors, CC-BY-SA", "https://heatmap-external-

b.strava.com/tiles/all/bluered/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "15", "0"]) 

sources.append(["connections-xyz","Strava Run", "", "", "OpenStreetMap 

contributors, CC-BY-SA", "https://heatmap-external-

b.strava.com/tiles/run/bluered/%7Bz%7D/%7Bx%7D/%7By%7D.png?v=19", "", "15", 

"0"]) 

sources.append(["connections-xyz","Open Weather Map Temperature", "", "", "Map 

tiles by OpenWeatherMap, under CC BY-SA 4.0", 

"http://tile.openweathermap.org/map/temp_new/%7Bz%7D/%7Bx%7D/%7By%7D.png?APPID=1

c3e4ef8e25596946ee1f3846b53218a", "", "19", "0"]) 

sources.append(["connections-xyz","Open Weather Map Clouds", "", "", "Map tiles 

by OpenWeatherMap, under CC BY-SA 4.0", 

"http://tile.openweathermap.org/map/clouds_new/%7Bz%7D/%7Bx%7D/%7By%7D.png?APPID

=ef3c5137f6c31db50c4c6f1ce4e7e9dd", "", "19", "0"]) 

sources.append(["connections-xyz","Open Weather Map Wind Speed", "", "", "Map 

tiles by OpenWeatherMap, under CC BY-SA 4.0", 

"http://tile.openweathermap.org/map/wind_new/%7Bz%7D/%7Bx%7D/%7By%7D.png?APPID=f

9d0069aa69438d52276ae25c1ee9893", "", "19", "0"]) 

sources.append(["connections-xyz","CartoDb Dark Matter", "", "", "Map tiles by 

CartoDB, under CC BY 3.0. Data by OpenStreetMap, under ODbL.", 

"http://basemaps.cartocdn.com/dark_all/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "20", 

"0"]) 

sources.append(["connections-xyz","CartoDb Positron", "", "", "Map tiles by 

CartoDB, under CC BY 3.0. Data by OpenStreetMap, under ODbL.", 

"http://basemaps.cartocdn.com/light_all/%7Bz%7D/%7Bx%7D/%7By%7D.png", "", "20", 

"0"]) 

sources.append(["connections-xyz","Bing VirtualEarth", "", "", "", 

"http://ecn.t3.tiles.virtualearth.net/tiles/a{q}.jpeg?g=1", "", "19", "1"]) 

 

 

# Add sources to browser 
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for source in sources: 

   connectionType = source[0] 

   connectionName = source[1] 

   QSettings().setValue("qgis/%s/%s/authcfg" % (connectionType, connectionName), 

source[2]) 

   QSettings().setValue("qgis/%s/%s/password" % (connectionType, 

connectionName), source[3]) 

   QSettings().setValue("qgis/%s/%s/referer" % (connectionType, connectionName), 

source[4]) 

   QSettings().setValue("qgis/%s/%s/url" % (connectionType, connectionName), 

source[5]) 

   QSettings().setValue("qgis/%s/%s/username" % (connectionType, 

connectionName), source[6]) 

   QSettings().setValue("qgis/%s/%s/zmax" % (connectionType, connectionName), 

source[7]) 

   QSettings().setValue("qgis/%s/%s/zmin" % (connectionType, connectionName), 

source[8]) 

 

# Update GUI 

iface.reloadConnections() 

After runnint this code, a large list of Tiles server will be loaded into QGIS Browser and, of course, these layers 
can added to the map. 

 

Figure 82 - XYZ Tiles (Browser) 

It is easy to modify the list, or modify the parameter (right click of the mouse on the single “connection”): 

 

Figure 83 - XYZ Tiles - Manage the Connections 
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The list can be saved and retrieved (right click of the mouse on the “XYZ Tiles”): 

:  

Figure 84 - XYZ Tiles . New, Save, Load Connections... 

 

Before exporting the “connections” it is necessary to select the the name of the connections that we desire 

to save: 

 

Figure 85 - Select the Connections to Export... #1 

After selecting a list (or “Select all”) we have to confirm using the “Export” button: 

 

 

Figure 86 - Select the Connections to Export... #2 

QGIS will ask You to select a name and a folder in which save the XML file: 
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Figure 87 - Select the Connections to Export... #3 

From data to maps 

To improve our ability to “make maps” it is useful to search “ready to use” data, in GIS format. Previously we 

have talked about “Shapefile” but many other format exist. For example, GIS data can be “hidden” into a 

Text File or lives inside a Spreadsheet. The followin exercise will explain how to manage these information 

also. 

From Spreadsheet (to CSV) to Map 

The following image cames from World Heritage Center[83] and from this page it is possible to download the 

“World Heritage list”. 

 

 

Figure 88 - World Heritage List (WHC) 

By clicking on the download link (RSS, XML, KML, XLS) a page of “Terms and Conditions of Use” will be 

displayed: 

“Terms and Conditions of Use”[84] 

“UNESCO/WHC makes some of its web content available via syndication (XML/RSS/KML/XLS). An RSS icon 

appears on the syndication page, indicating those sections available for syndication. Whether you register as 

a subscriber or not, you must observe the following rules 

                                                           
83 https://whc.unesco.org/en/list/ 
84 https://whc.unesco.org/en/syndication 

https://whc.unesco.org/en/list/
https://whc.unesco.org/en/syndication
https://whc.unesco.org/en/list/
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This website and its content is protected by international law. Any republication, online or in any other form, 

of any UNESCO/WHC data requires prior written authorization. 

Individuals or organizations may ask for written permission to syndicate the content of the sections that are 

specifically made available (as indicated by the availability of the RSS icons mentioned above) for personal, 

non-commercial use, without fee. For more information, or to obtain an authorization, contact us. 

No modifications may be made to the content of any material that is syndicated. Changes you may make are 

limited to display typeface, typeface size, typeface color, and linebreaks. 

You may not sell, license, or otherwise assign the use of any of the material contained in UNESCO/WHC 

website. Each syndication use must include a link back to the UNESCO/WHC home page: 

https://whc.unesco.org as well as the specific item's page. The correct reference is included in the Channel 

Link element of the XML/RSS/KML/XLS feed.  

Each syndication use must include the following copyright notice: "Copyright © 1992 - [current year] 

UNESCO/World Heritage Centre. All rights reserved." The correct reference is included in the Channel 

Description element of the XML/RSS/KML/XLS feed. 

Syndication feeds are provided "as is" without warranty of any kind. UNESCO/WHC reserves the right to cancel 

this service at any time, without notice. 

Policy : Specific Requests (XML/RSS/KML/XLS) 

Sections that are not made available for syndication (as indicated by the availability of the XML/RSS/KML/XLS 

icons mentioned above) may not be "scraped" or otherwise syndicated in any manner. 

Individuals or organizations who wish to syndicate specific material must obtain a specific XML subscription 

and licence from UNESCO/WHC. This will imply a fee. UNESCO/WHC reserves the right to deny syndication 

licences at its sole discretion.  For more information, or to obtain an authorization, contact us”. 

 

Once upon the data (whc-sites-2019.xls) will be downloaded, we can use a spreadsheet software (Libre 

Office Calc or MS-Excel) to browse the data. 

The file just downloaded contains a great variety of information like: 

 

Figure 89 - World Heritage List (WHC) -The List of Sites -  Spreadsheet 

 

This is the complete attribute list  (extract from the QGIS Layer Properties, after loading the dataset): 
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All these fields need a “description”. All (GIS)data need appropriate “metadata”, or a “description” of the 

data itself (see “Metadata and License” section) to known “something more” about the fields . Among these, 

will find “several lines” (RECORDS) and “many columns” (FIELDS). Among these, LONGITUDE (X) and 

LATITUDE (Y) field will display info about the “position” of the related data. 

 

Figure 91 - Longitude and Latidude Fields 

The presence of these two colums (look at the value: a comma is used to separate the integer part from the 

decimal one) means that (maybe): 

 all the 1121 records have a “geographic location” (expressed by the coordinates) 

 each record (considering a couple of coordinates, LON and LAT) refers to a point expressed into 

Geographic Coordinate System (GCS) 

To make this MS-EXCEL a valid (Q)GIS data file is necessary to “export” it by using the command “Save as” 

into a Comma Separated Value (CSV) format. 

A CSV file is a (database saved into a) simple text file containing, in the first row, the column names separated 

by a special character. In many cases, is useful to use a semicolon (;) to divide the colums to avoid potential 

Figure 90 - World Heritage List (WHC) -The List of Sites -  Spreadsheet Fields detail 



                                                                                 A short intro to FLOSS, GIS, and QGIS 

loss of data (in fact, if we have decimal numeric value, according to the international settings of the Operating 

System in use into our PC,  they are expressed using points or virgulas to separate decimal values). 

Nevertheless, it is possible use a “new” separator, for example a “pipe character” (”|”) or another one. 

The “command”: “from MS-Excel to CSV” should be made using MS-EXCEL but… if we try to load it, as 

delimited text, into QGIS, the preview box will displayed “bad information”. 

Look at the “Sample data” box into the following image. 

In the first column should be appear the unique numbers (the codes) of the Heritage Site buti t is clear that 

in the Sample data box are living other information (such as the “Criterion”, descriptions and other notes). 

 

 

Figure 92 - Data Source Manager - Delimited Text #1 

Adding it to the map. 

 

Look at the blue points. If the creation of the map show several error (all the blu dots shoud be covered by 

the red ones: the data are the same…) 
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Figure 93 -Wrong Display of CSV 

The result is not compliant with QGIS “quality standards” because: 

 There are “special character” inside: <p>… <em>… <sup>… </sup>,  maybe from the HTML language 

that could “confuse” the data import process 

MS-Excel does not allows to modify directly the “field separator” (by defult the software use a particular 

character, derived from the International Settings of Your PC) when export a spreadsheet into Comma 

Separated Value (CSV)[85] [86] . In general, the semicolon character is used but inside the text are existing more 

semicolon yet. For example, in the record UNIQUE_NUMBER=1590, ID_NO=569 there is the following text: 

o <p>Berat and Gjirokastra are inscribed as rare examples of an architectural character typical 

of the Ottoman period. Located in central Albania, Berat bears witness to the coexistence of 

various religious and cultural communities down the centuries. It features a castle, locally 

known as the Kala, most of which was built in the 13th century, although its origins date back 

to the 4th century BC. The citadel area numbers many Byzantine churches, mainly from the 

13th century, as well as several mosques built under the Ottoman era 

which&nbsp;began&nbsp;in 1417. Gjirokastra, in the Drinos river valley in southern Albania, 

features a series of outstanding two-story&nbsp;houses which were developed in the 17th 

century. The town also retains a bazaar, an 18th-century mosque and two churches of the 

same period.</p> 

 The last but not least trouble comes from the the presence of “numbered list” in many cells: 

o <p><em>Criterion (ii):</em> The innovative architecture and decoration of the Minaret of 
Jam played a significant role in the development of the arts and architecture of the Indian 
sub-continent and beyond. </p> <p> <em> Criterion (iii): </em> The Minaret of Jam and its 
associated archaeological remains constitute exceptional testimony to the power and quality 
of the Ghurid civilization that dominated its region in the 12th and 13th 

                                                           
85 To operate this change: Click the Windows Start menu. Click Control Panel. Open the Regional and Language Options dialog box. Click the Regional Options Tab. Click Customize / 

Additional settings (Win10). Type a new separator in the List separator box. Click OK twice. 

86 https://superuser.com/questions/606272/how-to-get-excel-to-interpret-the-comma-as-a-default-delimiter-in-csv-files 

https://superuser.com/questions/606272/how-to-get-excel-to-interpret-the-comma-as-a-default-delimiter-in-csv-files
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centuries.</p><p><em>Criterion (iv): </em>The Minaret of Jam is an outstanding example 
of Islamic architecture and ornamentation in this region and played a significant role in their 
further dissemination.</p> 

Maybe, in the text, there are many “carriage return” codes (CR) that could make the transformation 
an hard process. 

 

All this warning will be dispalyed into QGIS also when the original MS-Excel file were exported into CSV 

without “processing” the data itself. 

By the way, if we’ll use “on the fly” MS-Excel we could “eliminate” the “Carriage Return” using the “search 

and replace” tool. In the dialog box (I apologize myself but the software I use is into italian language): 

 

 

 

 

 

 in the search option, press CRTL key + J letter 

 in the replace option, leave blank 

and press “Replace all” and then close the dialog. A message will say “603 replacements have been made”. 

Remember to save the XLS using another name.87 

Now, if You do not want to change the international setting of our PC (or You can not operate as 

Administrator or You prefer to use an open source software), it is possible to use Libre Office CALC. It is easy 

to export the spreadsheet choosing the separator character on-the-fly. 

Now, will try to use LinbreOffice Calc. 

 

First, we have to deactivate the button “Autofilter”:  

                                                           
87 When we manage data, it is useful to store the original one use a particular suffix like _ORI (that means “ORIGINAL”) to manage version and save backup data. The new output wil 

take another suffix, like _MOD (that means “MODIFY”). Following this method, the former wil be “whc-sites-2019_ORI.xls” and the latter: “whc-sites-2019_MOD.xls” 

Search 

ologize 

myself 

Replace 

apologize 

myself 

Replace  

All 

In this text box press CTRL+J . A 

small “point” will blink 
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And then: File, Save as… Choose “Text CSV” and check “Edit Filter Settings”: 

 

 

In the following dialog, LibreOffice CALC asks if we really want to use a “Text CSV format”. Confirm it. 

 

 

 

In the following dialog, LibreOffice CALC asks something about the “Character set” (depend on Your country 

and/or system settings); “Field Delimiter” (the separator character between the colums). Choose a “pipe” 

[character (“|”)] and leave blank the “String delimiter ”. Confirm it and close the dialog. 

 

Now, we’ll try and use QGIS software. 
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From the QGIS “Open Data Source Manager” button we must select “Delimited Text” and browse to look for 

the CSV file. 

 

Look at the “data preview” (Sample data): if this is “correct” we can go on. Press the “Add” button and then, 

“Close”. The Layer will be loaded as Point inside the QGIS map space. 

Please note that: 

 The background is missing. A blank page will appear “by default”. We can add basemap “as services” 

(WMS, WCS, WFS, Tiles…) and/or as “Raster Data” 

 The Longitude and Latitute fields - caming from the original XLS - have been “transformed” into points 

(X,Y) 

 Longitude and Latitude information means that the data are exressed into Geograhic Coordinate 

System. You can see this information in the little box, lower right of of screen. The code 4326 

(EPSG=4326)[88] [89] means that our project is working on that type of coordinates.  

                                                           
88 EPSG stands for European Petroleum Survey Group and is an organization that maintains a geodetic parameter database with standard codes, the 

EPSG codes, for coordinate systems, datums, spheroids, units and such alike. Additionally, this database contains the parameters for these objects or - 

if they can not easily be expressed as values - at least references to where such parameters can be found.  Every geographic object (coordinate system, 

spheroid, unit etc.) gets assigned a unique number. The database is under active maintenance. (http://support.virtual-

surveyor.com/en/support/solutions/articles/1000261353-what-is-an-epsg-code-) 

89 http://support.virtual-surveyor.com/en/support/solutions/articles/1000261353-what-is-an-epsg-code- 

 

http://support.virtual-surveyor.com/support/solutions/articles/1000261350
http://support.virtual-surveyor.com/solution/articles/1000261330
http://support.virtual-surveyor.com/support/solutions/articles/1000261329
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261353-what-is-an-epsg-code-
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261353-what-is-an-epsg-code-
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261353-what-is-an-epsg-code-
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Once upont the data will loaded into a correct way, it is better to save it into Shapefile format in order to 

create a GIS data format. 

Export Layer (Save as… command) 

To perform a data export, right click of the mouse on the layer name: 

 

 

A “Save Vector Layer as” dialog will appears. First of all, we need to change to output, fromn CSV to Shapefile 

(or other GIS format, if You like) 
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After choosing the file format, we need to browse for searching an appropriate folder and set the output file 

name. Remember, also, we need to specify the Coordinate Reference System (CRS)[90] 

 

                                                           
90 A Spatial Reference System (SRS) or Coordinate Reference System (CRS) is a coordinate-based local, regional or global system used to locate 

geographical entities. A spatial reference system defines a specific map projection, as well as transformations between different spatial reference 

systems. Spatial reference systems are defined by the OGC's Simple Feature Access using well-known text representation of coordinate reference 

systems, and support has been implemented by several standards-based geographic information systems. Spatial reference systems can be referred to 

using a SRID integer, including EPSG codes defined by the International Association of Oil and Gas Producers. It is specified in ISO 19111:2007 

Geographic information—Spatial referencing by coordinates, prepared by ISO/TC 211, also published as OGC Abstract Specification, Topic 2: Spatial 

referencing by coordinate.  

https://en.wikipedia.org/wiki/Coordinate_system
https://en.wikipedia.org/wiki/Map_projection
https://en.wikipedia.org/wiki/Open_Geospatial_Consortium
https://en.wikipedia.org/wiki/Simple_Feature_Access
https://en.wikipedia.org/wiki/Well-known_text_representation_of_coordinate_reference_systems
https://en.wikipedia.org/wiki/Well-known_text_representation_of_coordinate_reference_systems
https://en.wikipedia.org/wiki/Technical_standard
https://en.wikipedia.org/wiki/Geographic_information_system
https://en.wikipedia.org/wiki/SRID
https://en.wikipedia.org/wiki/Integer
https://en.wikipedia.org/wiki/EPSG_code
https://en.wikipedia.org/wiki/International_Association_of_Oil_and_Gas_Producers
https://en.wikipedia.org/wiki/ISO/TC_211
https://en.wikipedia.org/wiki/Open_Geospatial_Consortium
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Browse the folder and set the file name. Concerning the CRS, we have to remember that we are using data 

in which the coordinate were expressed into Longitude and Latitude. This means the data are in EPSG=4326, 

WGS 84 Geographic. If You remember the EPSG code You can put ii into the “Filter” to get the related CRS 
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On the bottom right of the dialog, a “validity zone” for that kind of EPSG is displayed. If You don’t know the 

CRS, please read the “Metadata” (a description of the data that should follows always the GIS layers) or, if 

we’re looking for vector data, open the *.PRJ or *.QPJ file using a Notepad: 

 

 

At the end, remember to click on “Save” to confirm the file export and close the dialog.  

Adding a label 

A new shapefile was created. Now we can use it on the map, maybe representing the data using a thematic 

view (distinguish them by type or characteristic) and so on. QGIS offer many other functions. For example, 

we can display not only the geometries but also some related information about the data itself, by placing a 

“Label”. To display a small label on the features, taking the information to display from the attribute tabe, go 

to the “Layer Properties” search for “Label” tab. 
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Figure 94 - Layer Properties – Labels #1 

Click on the pull down menu “No labels” and choose, for example, “Single label”. Search for the field 

containing the info that You want to use in the labels (for example, the site name or its characteristic). Try to 

use other option  

 

Figure 95 - Layer Properties – Labels #2 
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Figure 96 - Show Labels on Map 

Geographic or Projected Coordinate System? 

Before going on, we have to remember that, when we manage geographic data, we need to pay attention to  

“cordinates” (and, last but not least, to the “geographic conventions” of the place in which we want to 

operate). When we download (especially) GIS data we have to read the related metadata to know all about 

the creation process (including the CRS in use) and so on. If we need to “create” data, this procedure will 

depend on, for example, the basemap we are using and, in this case, we must derive the CRS [EPSG code] 

from it. 
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“Locations on earth are often expressed in geographic degrees (latitude and longitude). But when you are 

surveying you need to talk in meters and feet. This is because - depending on the application - you use a 

geographic or projected coordinate system” [91]. 

“Earth is a big blue marble that’s the shape of a sphere (or close to it). This is why a globe is the best way to 
represent the Earth”. 

“But globes are hard to carry in your suitcase and you can only see one side of the globe. On top of that, it’s 
hard to measure distances and they’re just not as convenient as paper maps. 

This is why we use map projections on globes and flatten it out in two-dimensions. But as you’re about to 
find out, you can’t represent Earth’s surface in two dimensions without distortion. 

On top of that, all types of map projections have strengths and weaknesses preserving different attributes”. 

“However, when you transfer a spherical shape to a flat surface, you approximate the true shape of the Earth. 
Depending on the map projection you choose, some projections may cause distance between features on a 
map to be preserved while distortion is introduced to shape. In some cases, area may be preserved while 
direction is distorted”. 

“Cartographers choose map projections that best represents the purpose, size and shape of the area of 
interest on the map”[92]. 

 

In the following imageg, ont the left, geographic coordinates and, on the right, how to projected the 

coordinates. 

               

Geographic 

“A geographic coordinate system (GCS) is a coordinate system which uses a three-dimensional spherical 
surface (ellipsoid) to define locations on the earth. A common choice of coordinates is latitude and longitude. 
For example, Leuven, Belgium is located on 50°52'47" North[93] and 4°42'01" East[94] in the WGS84 coordinate 
system”[95] [96] 

                                                           
91 http://support.virtual-surveyor.com/en/support/solutions/articles/1000261350-the-difference-between-a-geographic-and-a-projected-coordinate-system- 

92 https://gisgeography.com/map-projections/ 
93 “N” corresponds to Latitude (Y)  
94 “E” corresponds to Longitude (X) 
95 The value are expressed into DMS. DMS is the abbreviation for Degrees Minutes Seconds.(…). DMS are special type of units used for measuring angles, as an alternative to 

decimal way to stating the size of an angle. It is a known fact that there are 360 degrees in a whole circle, with 1/60th of those being 1 minute, and 1/60th of one minute being 1 second. 

DMS includes degrees (°), minutes ('), seconds (''), with the corresponding symbols. https://www.latlong.net/lat-long-dms.html 
96 But you can also express geographic coordinates in decimal degrees. It’s just another way to represent that same location in a different format. For example, here is New York City 

in decimal degrees: LATITUDE: 40.714 LONGITUDE: -74.006 (that is the same of LATITUDE: 40 degrees, 42 minutes, 51 seconds N LONGITUDE: 74 degrees, 0 minutes, 21 

seconds W). https://gisgeography.com/decimal-degrees-dd-minutes-seconds-dms/ 

https://gisgeography.com/ellipsoid-oblate-spheroid-earth/
https://gisgeography.com/map-distortion-tissots-indicatrix/
http://support.virtual-surveyor.com/support/solutions/articles/1000261329
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261350-the-difference-between-a-geographic-and-a-projected-coordinate-system-
https://gisgeography.com/map-projections/
https://www.latlong.net/lat-long-dms.html
https://gisgeography.com/decimal-degrees-dd-minutes-seconds-dms/
https://gisgeography.com/decimal-degrees-dd-minutes-seconds-dms/
https://2012books.lardbucket.org/books/geographic-information-system-basics/s06-02-map-scale-coordinate-systems-a.html
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“A geographic coordinate system is constituted by a datum (DATUM), a prime meridian (PRIMEM) and unit 
(UNIT). The datum is constituted by a ellipsoid model (SPHEROID) and a anchor point. 

An example is: 

 WGS84 coordinate system with unique EPSG code 4326 

When working with data in a geographic coordinate system, it is sometimes useful to equate the longitude 

values with the X axis and the latitude values with the Y axis”[97]. “Because degrees of latitude and longitude 

don't have a standard length, you can’t measure distances or areas accurately or display the data easily on a 

flat map or computer screen[98]”. 

Projected 

“In a projected coordinate system (PCS) you project the geographic coordinate that you have measured, to, 
for example, a cylinder which you roll out easily on two-dimensional surface (the map). There exist many 
different projections and we'll not go in further detail about that here. 

Typically every country, state or region has its optimal projected coordinate system which minimizes 
distortions for particular applications like mapping. 

Examples are: 

 South central Texas in the United States uses "NAD83( NSRS2007) / Texas South Central (ftUS)" with 

unique EPSG code 3674 

 Belgium uses "ETRS89 / Lambert 2008" with unique EPSG code 3812 

A projected coordinate system is constituted by a geographic coordinate system from which it is projected 
(GEOGCS) and other projection parameters like the measurement unit (UNIT) like meter or US Survey Foot), 

the projection technique and its projection parameters”[99]. 

Working with the table 

We have seen previously an “attribute table”. This “database” can store several information. We can manage 

the data, perform calculations, adding and removing columns (i.e. a FIELDS) without modifying the number 

of geometric feature existing in the layer. When we delete a row (i.e. a RECORD), instead, will delete also the 

related geometry (a point, a polyline, a polygon). 

Look at the layer of the World Heritage Center,“whc-sites-2019”, and open the attribute table. We have to 

decode some “information” (METADATA). Fields from [C1] to [C6] are referring to “Cultural Heritage” while 

fields from [N7] to [N10] to “Natural Heritage”.[100] 

List of Criteria 

(i) represent a masterpiece of human creative genius; 

(ii) exhibit an important interchange of human values, over a span of time or within a 

cultural area of the world, on developments in architecture or technology, monumental 

arts, town-planning or landscape design; 

(iii) bear a unique or at least exceptional testimony to a cultural tradition or to a civilization 

which is living or which has disappeared; 

                                                           
97 https://desktop.arcgis.com/en/arcmap/10.3/guide-books/map-projections/about-projected-coordinate-systems.htm 
98 https://desktop.arcgis.com/en/arcmap/10.3/guide-books/map-projections/about-geographic-coordinate-systems.htm 
99 http://support.virtual-surveyor.com/en/support/solutions/articles/1000261350-the-difference-between-a-geographic-and-a-projected-coordinate-system- 

100 https://whc.unesco.org/en/guidelines/ 

http://support.virtual-surveyor.com/support/solutions/articles/1000261330
http://support.virtual-surveyor.com/support/solutions/articles/1000261330
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261351
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261353
http://support.virtual-surveyor.com/support/solutions/articles/1000261353
http://support.virtual-surveyor.com/support/solutions/articles/1000261353
https://desktop.arcgis.com/en/arcmap/10.3/guide-books/map-projections/about-projected-coordinate-systems.htm
https://desktop.arcgis.com/en/arcmap/10.3/guide-books/map-projections/about-geographic-coordinate-systems.htm
http://support.virtual-surveyor.com/en/support/solutions/articles/1000261350-the-difference-between-a-geographic-and-a-projected-coordinate-system-
https://whc.unesco.org/en/guidelines/
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(iv) be an outstanding example of a type of building, architectural or technological ensemble 

or landscape which illustrates (a) significant stage(s) in human history; 

(v) be an outstanding example of a traditional human settlement, land-use, or sea-use which 

is representative of a culture (or cultures), or human interaction with the environment 

especially when it has become vulnerable under the impact of irreversible change; 

(vi) be directly or tangibly associated with events or living traditions, with ideas, or with 

beliefs, with artistic and literary works of outstanding universal significance. (The 

Committee considers that this criterion should preferably be used in conjunction with 

other criteria); 

(vii) contain superlative natural phenomena or areas of exceptional natural beauty and 

aesthetic importance; 

(viii) be outstanding examples representing major stages of earth's history, including the 

record of life, significant on-going geological processes in the development of landforms, 

or significant geomorphic or physiographic features; 

(ix) be outstanding examples representing significant on-going ecological and biological 

processes in the evolution and development of terrestrial, fresh water, coastal and 

marine ecosystems and communities of plants and animals; 

(x) contain the most important and significant natural habitats for in-situ conservation of 

biological diversity, including those containing threatened species of Outstanding 

Universal Value from the point of view of science or conservation. 

The table is an “internal database” and it is possible to find, manage, assembre, disassemble the “tabular 

information”. 

Select feature by expression 

 

This function allows to search for a particular value or string inside the database. For example, We deside to 

select all the feature that: 

category = Cultural <and> region_en = Europe and North America 

Press the Button and open the “Select by Expression” dialog: 

 

https://docs.qgis.org/3.4/pdf/en/QGIS-3.4-UserGuide-en.pdf
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Figure 97 - Select by Expression #1 

In the “central frame” click on “Fields and Value”. This will show all the fields existing into the attribute table. 

Other functions are group by title. Browse Yourself and explore! 

 

Figure 98 - Select by Expression #2 

Search for the field “category” and double click it; search for the field “region_en” and double click it. An 

error message will be displayed on the bottom left: 
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Figure 99 - Select by Expression #3 

The “Output preview”, when a syntax error is detected, will show an error message.  

The frame under “All Unique” and “10 Sample” buttons will show the unique value or ten sample only: 

 

Figure 100 - Select by Expression #4 
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If you select a Field and press ”All Unique” (value) in the related windows will appear the unique value(s) that 

existing in the selected column. This derives from SQL language, “select” command with the “distinct” 

option.[101] 

We have added the fields but we need to set the “conditions”. Write (or compose it using the dialog facilities) 

the following string and paste it into the dialog: 

"category" = 'Cultural'  AND  "region_en" = 'Europe and North America' 

In the previous expression, AND means that the two condition must be contemporary satisfied. OR, instead, 

means or the first condition or the second and, probably, will retuns more hits. 

Note that fields are written into “double quotes” while text is into ‘single quotes’ (number will be written 

without any other particular character). 

 

Figure 101 - Select by Expression #5 

The results of this selection will be displayed both on the table and both on the map canvas. By default, in 

the table the selected records are in blue: 

                                                           
101 w3schools.com/sql/sql_distinct.asp 
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Figure 102 – Records Selected 

On the map, the selected objects are in yellow: 

 

Figure 103 – Feature Selected 

Starting with the active selection, we could create a new vector layer, exporting only the selected feature. 

Using the right click of the mouse on the layer name: 
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Figure 104 - Save Selected Features As... #1 

 

 

 

Figure 105 - Save Selected Features As... #2 
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Browse the folder structure, choose a name for the new layer and press OK. If You need to change the 

Coordinate Reference System (CRS), reprojecting the data,press the CSR button and select the appropriate 

creference system before confirming the export procedure and close the dialog. 

If we need to create (or to delete) a column it is necessary to open an “edit session” 

Editing functions 

Depending on the situation (we are working on a map or on a table?) the button will change consequently. 

In a table we can not draw (“geometrically”) a point and in the map, displaying a vector laver, we can not 

add a field in the related table. 

Edit (Geometric) Feature 

Following table cames from QGIS Manual[102] 

Before starting, we need a basemap. Is is possibile to use a raster image, an OGS Service (WMS, WCS, WFS) 

or an XYZ Tiles. Depending on the situation, we can choose. By the way, if We can use an internet access, the 

XYZ Tiles are faster and cover all the world. 

Add a XYZ Tiles Basemap 

We have seen how to load a list of XYZ Tiles and to display a basemap. Choose from the XYZ Tiles “Google 

Maps” and double click on it to add to layer list. Search for Vatican City (Rome, Italy), St. Peter’s Basilica. To 

recognize the place add “Google Satellite” also 

 

Note that the CRS is changed from EPSG 4326 to EPSG 3857 (Keep it in Your mind). Add Google Satellite also. 

                                                           
102 https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html 

https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html
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Figure 106- Google Maps 

 

Figure 107 - Google Satellite 

If you do not see the Basilica move the layer up or down the image (dragging and dropping it into the Layer 

Panel). Remember that in GIS, layers follow the “Rule of Sandwich”: the slice of ham hide cheese. So, if You 

want to see the first You have to put it on the other one (when You eat a sandwich, isntead, the taste will 

be a complex and will never mind the ingredients order). 

Zoom on it. 

 



                                                                                 A short intro to FLOSS, GIS, and QGIS 

 

Figure 108 - St. Peter Basilica 

Add a Spatial Bookmark 

When we have found the “place” we could add a “Spatial Bookmark” just to retrieve it easier next ime. To 

“save” this location: View ‣ New Spatial Bookmark… (or CTRL+B). In Figure 110 the dialog in which to 

operate to set a name of the bookmark (a Group…) and other options. 

Spatial Bookmark can managed or retrieved using the Panel or the Browser. 

 

 

Figure 109 - Spatial Bookmark 

New Spatial Bookmark… (CTRL + B) : Create a New Bookmark (Figure 110) 
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Figure 110 – Bookmark Editor - Add a Spatial Bookmark #1 

 

 

Figure 111 – Bookmark Editor - Add a Spatial Bookmark #2 

Show Spatial Bookmarks (CTRL + SHIFT + B): Show Spatial Bookmark in “Browser Panel” (Figure 112) 

The “Save” button will set the Spatial Bookmark -  and the Group, if present – into the “Browser”, “User 

Bookmark”, “Spatial Bookmark”: 
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Figure 112 - Spatial Bookmarks - User Bookmarks 

Show Spatial Bookmark Manager: show the new “Spatial Bookmark Manager” Panel. 

 

Figure 113 - Spatial Bookmark Manager 

Start Editing 

The goal is to create a two vector layers: MONUMENTS OF ROME (POINTS) and MONUMENTS OF ROME 

(POLYGON). 

 in the former, a point layer (in which save “monuments” such as “obelisk” and so on) 

 in the latter, a polygon layer (in which save “monuments” such as a “colonnade”, the “Colosseo”, 

drawing a polygon that “wrap” completely the object). 

Of course, we need of an empty shapefile in wich save our work (or we could use an existing one, but this is 

not the case). 

Create a Point Layer 

To create a new vector layer, Layer ‣ Create Layer ‣ New Shapefile Layer: 
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Figure 114 - Create a Vector Layer 

or, if You prefer, it is possible to use a button . A new dialog will appears: 

 

Figure 115 - Create a Vector Layer (detail #1) 

 Browse for an appropriate folder in wich save the shapefile and chosse for a file name “Monuments 

in Rome” (MIR); 

 Choose the “Geometry type” (Point, Multipoint[103], Line, Polygon); 

 Set the Coordinate Reference System (do You remember anything the base map we are using?); 

 Add some attribute fields (a “code”, numeric; a description, text). 

The basemap we are using use an EPSG = 3857. This is why we need to put it into the related field in order to 

make the base map and the vector layer “compatible”. 

                                                           
103 Sometimes one geometry is actually a collection of simple (single-part) geometries. Such a geometry is called a multi-part geometry. If it contains just one type of simple geometry, 

we call it multi-point, multi-linestring or multi-polygon. For example, a country consisting of multiple islands can be represented as a multi-polygon. 
https://docs.qgis.org/2.18/en/docs/pyqgis_developer_cookbook/geometry.html 

https://docs.qgis.org/2.18/en/docs/pyqgis_developer_cookbook/geometry.html
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Figure 116 - Create a Vector Layer (detail #2) –MIR = Monuments in Rome 

Add an attribute field: [code], numeric, lenght = 10. Using “Add to Fields List” this field will saved into the 

attribute table 

 

Figure 117 - Create a Vector Layer (detail #3) 

Add an attribute field: [desc], text, lenght = 255. Using “Add to Fields List” this field will saved into the 

attribute table.  
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Figure 118- Create a Vector Layer (detail #4) 

 

Figure 119 - Create a Vector Layer (detail #5) 

Press “OK” to save the new shapefile with the fields described before. The new “empty” layer will be 

displayed into the Layer Panel: 
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Figure 120- The  new layer is loaded into the Layer Panel 

Before starting, look at the buttons that we can use inside an “edit session”: 

Icon Purpose Icon Purpose 

 

Current edits 
 

Toggle editing 

 

Save layer edits   

 

Add new record 
 

Add Feature: Capture 
Point 

 

Add Feature: Capture Line 
 

Add Feature: Capture 
Polygon 

 

Vertex Tool (All Layers) 
 

Vertex Tool (Current 
Layer) 

 

Modify the attributes of all 
selected features simultaneously 

  

 

Delete Selected 
 

Cut Features 

 

Copy Features 
 

Paste Features 

 

Undo 
 

Redo 

Table 4 -  Editing Geometries (buttons) 

Click on the layer name. Press the “Pencil” button to start an “Edit Session”. The “staus” of the layer 

“obelix” will change: 

 

Figure 121 - An edititing session is started on the new layer 

https://docs.qgis.org/testing/en/_images/mActionAllEdits.png
https://docs.qgis.org/testing/en/_images/mActionToggleEditing.png
https://docs.qgis.org/testing/en/_images/mActionSaveEdits.png
https://docs.qgis.org/testing/en/_images/mActionNewTableRow.png
https://docs.qgis.org/testing/en/_images/mActionCapturePoint.png
https://docs.qgis.org/testing/en/_images/mActionCaptureLine.png
https://docs.qgis.org/testing/en/_images/mActionCapturePolygon.png
https://docs.qgis.org/testing/en/_images/mActionVertexTool.png
https://docs.qgis.org/testing/en/_images/mActionVertexToolActiveLayer.png
https://docs.qgis.org/testing/en/_images/mActionMultiEdit.png
https://docs.qgis.org/testing/en/_images/mActionDeleteSelectedFeatures.png
https://docs.qgis.org/testing/en/_images/mActionEditCut.png
https://docs.qgis.org/testing/en/_images/mActionEditCopy.png
https://docs.qgis.org/testing/en/_images/mActionEditPaste.png
https://docs.qgis.org/testing/en/_images/mActionUndo.png
https://docs.qgis.org/testing/en/_images/mActionRedo.png
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Look for the button  (Add Point Feature) and click on it. Now, go to the map and click on the “obelisk”. 

A new dialog will appears: 

 

Figure 122- Adding attribute values 

The [id] field was created by the system (at least, one field is mandatory to manage a GIS layer). [code] and 

[desc] are the two fields create just a couple of seconds before. Inser values (i.e. a numeric value, a 

description) and press “OK”. Try to insert other “monuments” (the code=1 is not usable for other objects: 

create a new code for each one). Remember to save  regularly Your works. At the end, press the pencil 

again to “Toggle Editing”. QGIS will ask to You: 

 

Figure 123 - Stop Editing dialog 

“Cancel” interrupt the request and go back to editing; “Discard” close the edit session without saving; “Save” 

stores the information and xit from editing. 

Open the attribute table: 

 

Figure 124 - The Attribute table after editing 

Look for the button (“Identify Features”) and click on the “obelisk”: 

https://docs.qgis.org/testing/en/_images/mActionCapturePoint.png
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Figure 125 -  Identify Feature dialog 

 

Create a Polygon Layer 

Following the previous part, try to create a Polygon Layer. Take into account that when you are working on 

polylines or polygon, to avoid errors, is better to set the Tolerance, the Snap and -  enable the “Topological 

Editing”[104][105]. Try to look at the Project ‣ Snapping Options… settings and related help[106]. 

When a Polygon Layer is created it appears: 

in the Layer Panel: 

 

Figure 126 -  Layer Panel (polygon) 

on the map, when You draw a polygon 

                                                           
104 https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html#id32 
105 https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html?highlight=edit%20feature 
106 https://docs.qgis.org/3.10/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html?highlight=snapping 

https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html#id32
https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html?highlight=edit%20feature
https://docs.qgis.org/3.10/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html?highlight=snapping
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Figure 127 - Draw a Polygon 

As result from Figure 127, when we have to “digitize” a polygon is better tho change the representation of 

the “geometry”, choosing, in the Layer Properties, Fill style = “No Brush” in order to obtain: 

in the Layer Panel: 

 

Figure 128 -  Layer Panel (polygon, "no brush") 

on the map: 

 

Figure 129 - Figure 17 - Draw a Polygon (no brush) 

To change the Symbology (see «The “Layer Properties”» section). In order to pass from this representations: 
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Figure 130 - Layer Properties (Polygon Symbology #1) 

to this  one: 

 

Figure 131 -  Layer Properties (Polygon Symbology #2) 

We have to click on “Simple fill” and, then, “Fill style” = “No Brush”. Maybe it is convenient to modify also 

the “Stroke witdth” in order to make more visible the “boundaries” of the geometries. 
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Figure 132 -  Layer Properties (Polygon Symbology #3) 

Use the “Vertex Tool”  to refine the “boundary”. Double click on a shape add a vertex.  

 

Figure 133 - Vertex Tool #1 

When You have finished, “Toggle Editing”: 
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Figure 134 - Stop Editing Dialog 

And save Your work. 

But… “Houston… we have a problem”! If we change again the “Layer Properties” and roll back to activate 

the “Fill style” = “Solid”, the polygon we have just drawn will be the following one: 

 

Figure 135 - Fill style = Solid 

What is the problem? Our work is missing of an “hole”… so, go back to an “Edit Session” and look for the 

“Add Ring” button ( ). Then draw “a shape” inside the previous one.  
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Figure 136 - Adding a Ring 

Then go back to the “Vertex Tool” and adjust the vertices (creating, deleting…).To do this is better to use the 

“No Brush” option in order to see the basemap on the background. 

 

Figure 137 - Vertex Tool #2 

Edit the attribute table 

The first button on the left of the table is a “Pencil”. ThTis icon stands for “Start an edit session” or “Toggle 

Editing”. Remember that the table is linked to the data layer so when You’ll detete a recond a feature (in 

this case, a point) will deleted from the map.  
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Following table cames from QGIS Manual[107] 

Icon Label Purpose 
Default 

Shortcut 

 

Toggle editing mode 
Enable editing 
functionalities 

Ctrl+E 

 

Toggle multi edit mode 
Update multiple fields of 
many features 

 

 

Save Edits Save current modifications  

 

Reload the table   

 

Add feature 
Add new geometryless 
feature 

 

 

Delete selected 
features 

Remove selected features 
from the layer 

 

 

Cut selected features 
to clipboard 

 Ctrl+X 

 

Copy selected features 
to clipboard 

 Ctrl+C 

 

Paste features from 
clipboard 

Insert new features from 
copied ones 

Ctrl+V 

 

Select features using 
an Expression 

  

 

Select All 
Select all features in the 
layer 

Ctrl+A 

 

Invert selection 
Invert the current selection 
in the layer 

Ctrl+R 

 

Deselect all 
Deselect all features in the 
current layer 

Ctrl+Shift+A 

 

Filter/Select features 
using form 

 Ctrl+F 

 

Move selected to top 
Move selected rows to the 
top of the table 

 

                                                           
107 https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html 

https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html
https://docs.qgis.org/testing/en/_images/mActionToggleEditing.png
https://docs.qgis.org/testing/en/_images/mActionMultiEdit.png
https://docs.qgis.org/testing/en/_images/mActionSaveEdits.png
https://docs.qgis.org/testing/en/_images/mActionDraw.png
https://docs.qgis.org/testing/en/_images/mActionNewTableRow.png
https://docs.qgis.org/testing/en/_images/mActionDeleteSelectedFeatures.png
https://docs.qgis.org/testing/en/_images/mActionEditCut.png
https://docs.qgis.org/testing/en/_images/mActionCopySelected.png
https://docs.qgis.org/testing/en/_images/mActionEditPaste.png
https://docs.qgis.org/testing/en/_images/mIconExpressionSelect.png
https://docs.qgis.org/testing/en/_images/mActionSelectAll.png
https://docs.qgis.org/testing/en/_images/mActionInvertSelection.png
https://docs.qgis.org/testing/en/_images/mActionDeselectAll.png
https://docs.qgis.org/testing/en/_images/mActionFilterMap.png
https://docs.qgis.org/testing/en/_images/mActionSelectedToTop.png


                                                                                 A short intro to FLOSS, GIS, and QGIS 

 

Pan map to the 
selected rows 

 Ctrl+P 

 

Zoom map to the 
selected rows 

 Ctrl+J 

 

New field 
Add a new field to the data 
source 

Ctrl+W 

 

Delete field 
Remove a field from the 
data source 

 

 

Open field calculator 
Update field for many 
features in a row 

Ctrl+I 

 

Conditional formatting Enable table formatting  

 

Dock attribute table 
Allows to dock/undock the 
attribute table 

 

 

Actions 
Lists the actions related to 
the layer 

 

Table 5 -  Editing Attribute Table (buttons) 

Starting from the attribute table: 

 

Figure 138 - The Attribute Table 

The exercise could be to try to “transpose” the value of field [criteria_t] as the “concatenation” of the 

fields: [C1];[C2];[C3];[C4];[C5];[C6];[N7];[N8];[N9];[N10], putting between values a “minus sign”. 

In other words, we would insert in all the record a sting like this: “0-0-0-0-0-0-0-1-0-0” 

(this is valid for the first record and will be change for the others). 

After pressing the “Toggle editing” mode , the button “New field”  will be active. 

 

Figure 139 - Add Field Dialog #1 

https://docs.qgis.org/testing/en/_images/mActionPanToSelected.png
https://docs.qgis.org/testing/en/_images/mActionZoomToSelected.png
https://docs.qgis.org/testing/en/_images/mActionNewAttribute.png
https://docs.qgis.org/testing/en/_images/mActionDeleteAttribute.png
https://docs.qgis.org/testing/en/_images/mActionCalculateField.png
https://docs.qgis.org/testing/en/_images/mActionConditionalFormatting.png
https://docs.qgis.org/testing/en/_images/dock.png
https://docs.qgis.org/testing/en/_images/mAction.png
https://docs.qgis.org/testing/en/_images/mActionToggleEditing.png
https://docs.qgis.org/testing/en/_images/mActionNewAttribute.png
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Choose a name for the field, i.e. “CRITERIA_N” (sorry: max 10 charaxcter are allowed in DBF files), even a 

comment for the field (it is not mandatory), choose the field type (Number, Text) and the “length” (How 

many characters? How many numbers?).  

 

Figure 140 - Add Field Dialog #2 

Fill the dialog with the information required: 

 

Figure 141 - Add Field Dialog #3 

and press OK to confirm. 

The new fileld will appear on the table, as the last field on the right.  

Open the “Field Calculator” . We can choose between to “Create a new field” or “Update an existing 

one”. Choose the second option (we have just created a new field) and choose the field to update: 

 

https://docs.qgis.org/testing/en/_images/mActionCalculateField.png
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In the “Function Panel” in the center of the dialog, search for “Fields and Values” and explode the list: all the 

fields of the table will displayed. Double click on the single field of interest, i.e. 

[C1];[C2];[C3];[C4];[C5];[C6];[N7];[N8];[N9];[N10]. 

These fields will be placed, into the left frame, inside the “Query Compositor” frame. 

“Function 

Panel” 
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Figure 142 - Field Calculator - Concatenate Function #1 

In the “Output preview” an error is displayed: the syntax of the query is not correct. We have to insert the 

missing operators. In other word, we want to “concatenate” several values. To perform this operation we 

need the appropriate function: “concat”. Browse the “Function Panel” and search for: String ‣ Concat 

An help will displayed: 

function concat 

Concatenates several strings to one. NULL values are converted to empty strings. Other 

values (like numbers) are converted to strings. 

Syntax 

concat(string1,string2…) 

Arguments 

 

string a string value 

Examples 

FIELDS 
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 concat('sun', 'set') → 'sunset' 

 concat('a','b','c','d','e') → 'abcde' 

 concat('Anno ', 1984) → 'Anno 1984' 

concat('The Wall', NULL) → 'The Wall' 

Starting from the example, to correct the syntax error in the query we have composed, we need to insert 

the concat function as follow: 

concat( "C1",'-',"C2" ,'-', "C3",'-', "C4",'-', "C5" ,'-', "C6" ,'-', "N7",'-', "N8" ,'-', "N9" ,'-', "N10") 

Where 

 Concat() is the function that we want to apply 

 “C1”… are the fields (between double quotes) 

 '-' is the separator value (it is a text, so we need to put it into single quotes) 

If no errors are detected, the “Output preview” will display: 

 

Figure 143 - Field Calculator - Concatenate Function #2 

The button “OK” will confirm the operation and all the new values will be written for all the records.  

If You do not want to use “a function” and prefer a single operator You can use the || instead. The new 

expression will be: 

HELP 

Concat 

Function 
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"C1"||'-'||"C2" ||'-'|| "C3"||'-'||  "C4"||'-'||  "C5" ||'-'|| "C6" ||'-'|| "N7"||'-'||  "N8" ||'-'|| "N9" ||'-'|| 

"N10" 

 

Figure 144 - Field Calculator - Concatenate Function #3 

All the data will be re-written in the same field. To save Your editing it is mandatory to press again the 

“Toggle editing” mode . A dialog will appears: 

 

Figure 145 - Stop Editing Dialog 

Press “Save” to confirm the operation; “Discard” will “undo” the “editing” and “Cancel” will exit without do 

anything. By saving the edit session the attribute table will populated with new values.  

Look at the table:  

https://docs.qgis.org/testing/en/_images/mActionToggleEditing.png
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Figure 146 - The Attribute Table after the "Concatenate" 

These values are LEFT ALIGNED because are TEXT (NUMERIC VALUES will be aligned on the RIGHT instead). 

In the “Function Panel” we can find a lot of functions and commands. For example, how calculate the area, 

the perimeter and the length of a geometry. If our database should contains information about population 

will be easy to calculate the variation (%) between two years or between two different census. In this case, 

the formula to apply is: 

 

PopVariation(%) = 
𝑃𝑜𝑝 (𝐸𝑛𝑑𝑖𝑛𝑔 𝑃𝑒𝑟𝑖𝑜𝑑)−𝑃𝑜𝑝(𝑆𝑡𝑎𝑟𝑡𝑖𝑛𝑔 𝑃𝑒𝑟𝑖𝑜𝑑)

𝑃𝑜𝑝 (𝑆𝑡𝑎𝑟𝑡𝑖𝑛𝑔 𝑃𝑒𝑟𝑖𝑜𝑑)
 * 100 

 

Add new (“external”) data (JOIN function) 

GIS data have geometries and attribute data “inside”, into the same container. But the attribute data (DBF 

stands for Data Base File) is suitable itself to “JOIN” other “external” table. 

 

Figure 147 - The Atribute Table 

The [unique_num] field is, probably, the primary key of the database. 

Imagine that we desider plan a journey and visit cultural and natural sites listed before [unique_num]: 

230; 234; 1590; 1563; 111 
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We would add to the table some information, such as a “Y” (YES), a month and a year (for the travel). 

Open Yout text editor and create Your first Database (CSV format). 

In the first line, we have to write the column names, separated by a semicolon, for example: 

CODE; VISIT;MONTH;YEAR; 

In the other lines, the data You want to JOIN to the shapefile: 

230;Y;JANUARY;2022; 

234;Y;JUNE;2021; 

1590;Y;SEPTEMBER;2225; 

1563;Y;DECEMBER;2223; 

111;Y;APRIL;2225; 

The result will be: 

CODE;VISIT;MONTH;YEAR; 

230;Y;JANUARY;2022; 

234;Y;JUNE;2021; 

1590;Y;SEPTEMBER;2225; 

1563;Y;DECEMBER;2223; 

111;Y;APRIL;2225; 

Save Your File into Your working folder as “journey.csv” (defore saving, change the type from text to All 

files” *.*) 

 

Figure 148 - Save as Dialog - CSV format 
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As seen before, open the  Data Source Manager (Ctrl+L) and search for “Delimited Text”. Browse the 

file explorer until “journey.csv”: 

 

Figure 149 - Data Source Manager - Add a Demimited Text #1 

Click on “Custom delimiters”, than on “semicolon” and – under the Geometry definition – “No geometry 

(attribute only table)” 

https://docs.qgis.org/3.10/en/_images/mActionDataSourceManager.png
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Figure 150 - Data Source Manager - Add a Demimited Text #2 

Now, “Add” and “Close” the dialog. 

The table will added to the “Layers Panel”:  

 

Figure 151 - Layer Panel - Add Table 

With the mouse on the table name, right click and open the table: 
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Figure 152 - The Journey Table 

We have created a DB and we have loaded it into QGIS. Now we want to JOIN this table with the data coming 

from WHC. 

Right click on the WHC layer name and choose “Properties”. Search for “JOIN” and click on it”. 

 

Figure 153 - Layer Properties - Join #1 

In order to add a condition (create a relationship between WHC data and the new table) we have to select 

the Plus sign. As “Join layer”, select the new table; as “Join field”, select the field of the new table [CODE] 

that contains the “unique code”, useful to link data with WHC; as “Target field”, the unique code 

[unique_nume] of WHC data. 
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Figure 154 - Layer Properties - Join #2 

Press “OK” to confirm and close the dialog. 

 

Figure 155 - Layer Properties - Join #3 

Press “Apply” to confirm and “OK”to close the dialog and exit. 

Now re-open the attribute table of WHC: 
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Figure 156 - The WHC Table after a Join #1 

The number of (geometric) feature are the same (1121) but the procedure has added more columns: 

 

Figure 157 - The WHC Table after a Join #2 

The “field names” have, as suffix, the table name of origin: journey_VISIT; . journey_MONTH; journey_YEAR. 

No data (NULL) values are show because the JOIN puts into relationship only the matching codes 

Try to search for the code[108] that we have considered and use the “Select features using an expression” to 

build an appropriate query. 

The correct syntax should be: 

"unique_num" = 230 or "unique_num" = 234 or "unique_num" = 1590 or "unique_num" =1563 or 

"unique_num" = 111 

Remember that “Based on layer data and prebuilt or user defined functions, Expressions offer a powerful 

way to manipulate attribute value, geometry and variables in order to dynamically change the geometry 

style, the content or position of the label, the value for diagram, the height of a layout item, select some 

features, create virtual field …”[109] 

                                                           
108 230; 234; 1590; 1563; 111 
109 https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/expression.html#the-expression-string-builder 

https://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/expression.html#the-expression-string-builder
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Figure 158 - Select by Expression 

Select Features and close the dialog. 

In the table, five record are selected (use the “Show Selected Feature” filter) 

 

Figure 159 - The result of a "Select by Expression" 

In the map, five point are highlight (richt click on the layer name and choose “Zoom to Selection”) 
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Figure 160 - Zoom to Selection 

And, changing the layer fill colour (in yellow the points selected): 

 

Figure 161 - A Zoom to Selection 

Create Your Output 

Once upon our map is “complete” probably we decide to produce an “output”, i.e. a simple image, maybe a 

printed version or a professional template to publish it into an article or in a book. 

Selection 

Selection 
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Figure 162 - A simple map display 

Method 1: Export Map 

The easiest way is to export an image. From Project ‣ Import / Export ‣ Export Map to Image.  

 

Figure 163 - Export Map to Image 

This command will display a dialog in which we can set out some paramethers (such as the scale, the 

resoltution, output width and height and so on): 
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Figure 164 - Save Map as Image 

By pressing the “Save” button will open a new dialog, in wich we have to browse for a folder, to set an 

appropiate file name and a file format among these: 

 

Figure 165 - Choose an Image  file format 

Accord the settings, the procedure will export a georeferenced image: 

 

Figure 166 - Export a Georeferenced Image (with a SideCar file) 
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Export image or PDF 

As seen before, an export versus PDF is very similar. Project ‣ Import / Export ‣ Export Map to 

PDF… 

 

Figure 167 - Export Map to PDF 

The dialog is similar to the previous one. Explore You the difference: 
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Figure 168 - Save Map as PDF 

Creating a Layout 

We have producde simple images: these are missing of several information (a sort of short metadata just to 

describe the map process) such as: 

 Title 

 Legend 

 Scale (graphic and/or numeric) 

 North Arrow 

 Author name and / or note  

 Images 

 Diagrams 

 Copyright advice 

 Other 
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110 

Figure 169- Example of Printed Map111 

                                                           
110 https://docs.qgis.org/3.10/en/docs/training_manual/forestry/results_map.html?highlight=layout 
 

https://docs.qgis.org/3.10/en/docs/training_manual/forestry/results_map.html?highlight=layout
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This is why we have to create a Print Layout: Project ‣ New Print Layout… or (Ctrl+P). Enter a “unique 

print layout title”: 

 

Figure 170 - Create a Print Layout Title #1 

 

Figure 171 - Create a Print Layout 

Right click of the mouse into the “Layout Area” will let us to choose the “Page Properties…” and “Manage 

Guides for Page”: 

 

Figure 172 - Layout - Page Properties commad 

 

Layout 

Area  

Settings 
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Figure 173 - Layout - Page Size 

In this dialog is possible to set up the page format (A4, A3…), the orientation and so on.  

Add a Map 

“The map item is the main frame that displays the map you’ve designed in the map canvas.”[112] Use the  

(Adds a New Map to the Layout) button to inser a “Nem Map”. After clicking, click with the left button of the 

mouse, draw a box in the map area and release the mouse button. Remember to leave space fort the title, 

for the legend and for the other objects (but map space can be modify later also). 

 

Figure 174 - Layout - Insert Map#1 

 

                                                           
112 https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/composer_items/composer_map.html 

Map Area  

https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/composer_items/composer_map.html
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Figure 175 - Layout - Insert Map#2 

Add a Title or a Text Box 

To insert a title or a text box, use the button  (Adds a New Label to the Layout), click on the layout and 

if necessary, set the “New Item Properties”: 

 

Figure 176 - Layout - New Item Propoperties 
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Figure 177 - Layout – Insert Title#1 

Click ont the “Main Properties” and type the title. It is possible to choose the font, the positiona and size, 

margins, alignment and so on. 

 

Figure 178 - Layout . Insert Title#2 

Add a Legend 

Click on the button  (Adds a New Legend to the Layout) and, then, on a “white space”. As seen before, 

click on the layout and set the “New Item Properties”. Close the dialog and, if necessary, resize the object. 

Insert Title 
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Figure 179 - Layout - Insert Legend 

Add a Scale 

To add a scale bar[113] use the button  (Adds a New Scale _Bar to the Layout). As seen before, click on the 

layout and set the “New Item Properties”. Close the dialog and resize if necessary, the object. 

 

Figure 180 - Layout . Insert Scale Bar 

 

                                                           
113 https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/composer_items/composer_scale_bar.html 

https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/composer_items/composer_scale_bar.html
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Add a North Arrow 

Click on the button  “Add a New North Arrows to the Layout”[114]. As seen before, click on the layout 

and set the “New Item Properties”. Close the dialog and resize, if necessary, the object. 

 

Figure 181 - Layout - Insert North Arrow 

Export as PDF, SVG  or Image 

The buttons                   let You to Export (Print) Your Layout. If Your Project contains WMS layers, a 

warning will be dislapyed: 

Some WMS servers (e.g. UMN mapserver) have a limit for the WIDTH and HEIGHT parameter. Printing 

layers from such servers may exceed this limit. If this is the case, the WMS layer will not be printed 

 

Figure 182 - Layout - Project Contains WMS Layers 

Create and Publish a (simple WebGIS) using qgis2web 

“Web mapping is a great medium to publish your GIS data to the web and make it accessible by other users. 

Creating a web map is a very different process than creating one in a GIS. GIS users are typically aren’t web 

                                                           
114 https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/composer_items/composer_image.html?highlight=north 

https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/composer_items/composer_image.html?highlight=north


                                                                                 A short intro to FLOSS, GIS, and QGIS 

programmers and it presents a challenge when one needs to create a web map that is of the same quality as 

a map creating in a GIS. Fortunately, there are tools available to easily translate your work in QGIS to web 

maps”[115]. 

This chapter would introduce to WebGIS publishing. If we have to manage a “million of information” this is 

not the correct tool. To manage “hard data” is better and choose other architecture based on database: for 

example, LIZMAP on PostgreeSQL+PostiGIS database 

QGIS lets the user to add more functionalities to core sowftare. This is possible by using the Plugins ‣ 

Manage and Install Plugins Menu. The system will check the network 

 

Figure 183 - Plugins - Fetching Repositories 

and, if OK, a complete list of PLUGINGS will displayed on the screen. Look at the Plugin counter: 

                                                           
115 https://www.qgistutorials.com/en/docs/web_mapping_with_qgis2web.html 
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Figure 184 - The Plugins List 

It is possibible to “Upgrade” a single plugin or use the Upgrade All (the installed plugin) in order to keep align 

the software with the plugin version. 

If the Plugin counter does not show a similar numer probably there is a network trouble and maybe it is 

necessary: 

 Check the connection 

 Modify the Lan / Proxy Settings 

To check the connection, look at Your Router. Then, browse to the Plugins ‣ Manage and Install Plugins 

‣ Settings and look for the Status. If the sign is green all is OK: 
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Figure 185 - Plugins - Check the Internet Connection#1 

To verify, “globally”, the network, go to Settings ‣ Options ‣ Network and try to check “Use proxy for 

web access” and, in the Proxy type window, choose “DefaultProxy”. If these procedure do not resolve, ask to 

You System Administrator or Network Provider. 

Red or 

Green? 
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Figure 186 - Check the Internet Connection#2 

After resolving the network, we have to install the qgis2web plugin. Search for its name into the search 

window: 
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Figure 187 - Plugins - QGIS2WEB#1 

Select “qgis2web” and install the Plugin: 

 

Figure 188 - Plugins - QGIS2WEB#2 

After installing, the qgis2web appears with a check on the left. Now, it is possible to close the dialog. 
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Figure 189 - Plugins - QGIS2WEB#3 

Afetr installing the Plugin, a new Menu will appears. Go to Web ‣ qgis2web ‣ Create web map:  

 

Figure 190 - Web - QGIS2WEB Menu 

When “Create web map” is pressed a new window will appears. In this dialog there are many tabs (Layers 

and Groups; Appearance; Export; Settings; Help) in order to set up many parameters.  Many oh these they 

speak for themselves 

 

Figure 191 - Web - QGIS2WEB Interface #1 

The “Update Preview” button show a WEBGIS preview on the right panel; in order to produce a “service”, 

the radio button on the left lower let us to choose the “library”. In this example we will use the “Leaflet”[116] 

one. Finally, the “Export” button will produce the map. 

 

 

Figure 192 - Web - QGIS2WEB Interface #2 

                                                           
116 https://leafletjs.com/ 

https://leafletjs.com/
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Layers and Group: in this Tab is possible to operate on the single Layer: setting the visibility; activate popups; 

make clustering on; setting the label visibility for each field (no label, inline label or header label). 

 

Figure 193 - Web - QGIS2WEB Interface - Layers and Groups #1 

 

Figure 194 - Web - QGIS2WEB Interface - Layers and Groups #2 

Appearance: in this Tab we could add an abstract (None; Upper right; Lower right; Lower left; Upper left); 

add a search engine based on the addresses; add a layer list (None; Collapsed; Expanded); add a layer search 

engine; add a measure tool; set the template (canvas-size; full screen) and so on. 

Update 

Preview 
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Figure 195 - Web - QGIS2WEB Interface - Appearance 

Export: in this tab it is possible to set up the folder in which export the output process. It is better toi change 

the default one in order to set up out working folder. 

 

Figure 196 - Web - QGIS2WEB Interface - Export 

Settings:  in this tab, some options 



                                                                                 A short intro to FLOSS, GIS, and QGIS 

 

Figure 197 - Web - QGIS2WEB Interface - Settings 

Help: an help 

 

Figure 198 - Web - QGIS2WEB Interface - Help 

Once upon all the setting are OK it is possible to Export the map into an appropriate folder. Depending on 

the number of the features (and the basemap service, of course), the export process can take more or less 

time. When if finish, a dialog will appears. Press the “OK” button. 
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Figure 199 - Web - QGIS2WEB Interface - Exporting Progress Bar 

Depending on your system settings, a browser (Google Chrome, Microsoft Edge, Mozilla Firefox or others) 

will starts and the service will be loaded from local PC: 

 

Figure 200 - Web - The WEBGIS#1 

Since we have not added any extra functions, only the Zoom-In (+) and Zoom-Out(+) are available. Buti f we 

click on a point, we’ll get information caming from the attribute data: 
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Figure 201 - Web - The WEBGIS#2 

The “package” was saved into the specified folder (system we’ll use a system name suche as”qgis2web + 

“the_date” + “a_code”): 

 

Figure 202 - Web - The Export Folder 

In this folder will be created “subfolders”, in order to save “css (Cascade Style Sheet)”[117], data (converted 

into JSON format)[118], images, js (Leaflet javascript), legend, markers, webfonts. 

The “index.html” file is the “core” of the WEBGIS and manage the “service”. 

If we have the possibility to manage a WEB Server (i.e. Apache, Tomcat…), to “publish” our WEBGIS is 

enought to copy-and-paste all the folders (plus the HTML file) into a WWW folder of the WEB Server. If we 

have not this possibility, we can use it from local, starting it by clicking on the HTML file. 

                                                           
117 en.wikipedia.org/wiki/Cascading_Style_Sheets 
118 https://www.json.org/json-en.html 

https://www.json.org/json-en.html
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Figure 203 - Web - The System Folders and Files 

Adding some options (i.e. “clustering” “address search”, “layer list”, layer search on the english name of the 

site) the “Preview” will be: 

 

Figure 204 - Web - The WEBGIS with Option Buttons 

This is the “final” output: 
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Figure 205 - The WEBGIS - Final Output 

 

 
Zoom In  
 
Zoom Out 

 
Measure Distances and Areas 

 
Search for a Place 

 
Search… (inside the Layer) 

Table 6 - The WEBGIS - Buttons and Tools 

If Leaflet JS is able to “undestand” HTML code, it is possible to modify the popups in order to display images 

and / or PDT or other hyperlink. 

For example, for the International Project: “Woman’s Creativity since the Modern Movement (MoMoWo), 

1918-2018” we have built a WEBGIS in order to diplay Architects, Designers, Artist… on a map.  

MoMoWo - A WEBGIS Example: 

Let me to introduce you shortly to the MoMoWo Project 

Description: the Database includes biographies of women architects (civil engineers), interior and landscape 
designers, and urban planners. It will include entries on prominent and less-known figures from the past to 
the present days going beyond national partners interests in order to represent the different architecture 
and design movements in Europe. It’ll also include entries of European women who have worked and are still 
working in the EU and beyond.  The Database will contain biographical data, sketches, projects and 
drawings/graphics, photos and related documents also submitted by the audience. 
 
Objectives: the Database underpins the cultural activities of MoMoWo, it provides useful data and materials 
for lectures and public talks on European women’s role in design professions. The Database will provide 
scholars with new skills, capacities and know-how on the specific focus, including the encouragement to the 
use of digital technologies. 

http://www.momowo.eu/
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Beneficiaries: families, friends, colleagues of women architects and designers, critics, historians, scholars, 
journalists, curators, students, scholars and educators. 
 
Communication: selected results of the Database will be published on this website in order to disseminate 
to the public at large the knowledge of the lives and works of European women involved in design 
professions. Museums, private and public archives, such us companies archives, and foundations who will 
provide their documents for the database will be invited to spread the activity through links on their own 
official websites. 
 
Sustainability: the Database is designed to further develop the MoMoWo project as an european platform 
to be implemented throughout consequent attraction of participants from the EU and beyond. Beyond the 
project duration the data collected will be used for didactic purposes. 
 

This is the result of the (customized) WEBGIS: 

 

Figure 206 - The MoMoWo WEBGIS 

Customize Popup 

In this exercise, will use and operate on HTML language[119] 

Starting from the data loaded into QGIS and from the structure of folders created by qgis2web (Figure 203) 

it is possibile to customize the “popups”. Go to QGIS and load the “WHC sites” (refer to “Add a XYZ Tiles 

Basemap”). 

Zoom to the St Peter Basilica.  

                                                           
119 https://www.w3schools.com/ 

https://www.w3schools.com/
http://www.momowo.polito.it/#3/24.93/1.54
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Figure 207 - The St. Peter Basilica 

In the “Attribute Toolbar” search and use the “Select Features by area or single click”  . Use the tool to 

select the point labeled as “Cultural”. The point will “selected “by yellow: 

 

Figure 208 - The St. Peter Basilica - A point selection 

Open the “Attribute table” 

https://docs.qgis.org/3.10/en/_images/mActionSelectRectangle.png
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Figure 209 - The Attribute Data (Show All Records) 

Switch from “Show All Features” to “Show Selected Features” 

 

Figure 210 - The Atribute Data (Show Selected Features) 

To edit the data is better to switch to the “form view” instead: 

 

Figure 211 -  The Atribute Data (Show Selected Features) - Form View 
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The goal is to modify the attributes just for this record olnly in order to display a “customized popup”. The 

procedure can be used for all the others records. 

Browse the WEB. Choose an image of St. Peter and save it on your working folder. Choose a PDF file about 

St. Peter (or another PDF) and save it. Search for a related hyperlink and save into a Text Editor. 

Start an editing session, open the attribute table and add some fields: 

 PDF (Text, 255) 

 Image (Text, 255) 

 Links (Text, 255) 

Before going on, we have to remember a couple of HTML useful “commands” (just adapted to the data we 

have found): 

Open a Link 

<a href="https://en.wikipedia.org/wiki/St._Peter%27s_Basilica" target="_blank>St. Peter 

Basilica</a> 

Open an Image 

<img src=".\PHOTO\STPETER.JPG" alt="St. Peter" width="50%" height="auto">[120] 

Link to a document (PDF) 

<a href=".\PDF\STPETER.PDF">ST. PETER</a>[121] 

As we have seen before, qgis2web creates “a system” of files and folder in which it saves data, javascripts, 

and settings (Figure 203). After creating a WEBGIS (Web ‣ qgis2web ‣ Create web map) we need to 

add two subfolder, PDF and PHOTO, just to separate them from the system folders: 

 

Figure 212 - Web - The System Folders and Files - Custom Folders 

In these subfolders we must copy the PDF and the PHOTO that we deside to publish. We have to follows 

these steps each time will recreate the “webgis”. 

                                                           
120 If you are using a WEB Server (Apache...) it is mandatory to use a link to the WEB resource and not a local file 
121 If you are using a WEB Server (Apache...) it is mandatory to use a link to the WEB resource and not a local file 

https://en.wikipedia.org/wiki/St._Peter%27s_Basilica
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May be useful to “limit” the fields in the attribute table hiding the fields that we do not want to display. 

 

Figure 213 - Layer Properties - Attribute Form - Hide Fields #1 

 

Figure 214 - Layer Properties - Attribute Form - Hide Fields #2 

At the end of the settings, try again the Web ‣ qgis2web ‣ Create web map, create the folders, paste 

de files, and run the WEBGIS from local PC: 
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Figure 215 - WEB - QGIS2WEB - Custum Popup 

  



                                                                                 A short intro to FLOSS, GIS, and QGIS 

Project “management” 

In the “Project Environment”, we can “Create a New Project” or open an existing one,save, access to 

“Spatial Bookmarks” and set several options and parameters. 

 

When we save a Project we are saving a “link” to data and not data themselves. So, if we would  to pass to 

a Collegue of us a “Project” we have to share with him also the linked data. 

QGIS project file has *.QGZ extension (but we can still use *.QGS for backward compatibility). 

Important Settings 

In the Project ‣ Properties save “relative path” is very usefulf. 

Imagine to create your workspace – a folder: call it “FIRSTWORK” -  on disc “C”. This folder will be the “root 

folder” for YOURPROJECT. Starting from this FIRSTWORK folder create several subfolder in which store or 

save the original data, the data that you have modified, the output produced by you (images, layout export 

and so on), the documentation…  

If we have choosen to store relative path we can compress (ZIP )the root folder (“FIRSTWORK”) and pass it 

to a Collegue without any problem. Even if the Collegue should not have a disc “C” the project file will open 

itself and all the related data without any problem. If we do not use this option (leaving “absolute path”), 

moving the Project into another space will cause “problems”. At the startup, QGIS will ask you: where is the 

SHP1? Where is SHP2? And son on…  
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C:\  FIRSTWORK      

   YOURPROJECT     

   ORI_DATA     

    VECTOR SHP1 SHP2  

    RASTER TIFF1 TIFF2  

   MOD_DATA     

    VECTOR SHP11 SHP21  

    RASTER TIFF11 TIFF21  

   OUTPUT DOC1 DOC2 PDF1 JPG1 
 

Table 7  - How organise a Workspace 

             Are FOLDERS 

             Are FILES 
 

Given the above, to set up the relative path, go the “Project Properties” (CTRL + SHIFT + P) and, in the 

Generale Tab, set this option: 

 

Figure 216 - Project Properties - Set Relative Path 
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Figure 217 - Project Properties . General - Save Relative Path 

 

Settings ‣ Options ‣ Network        

Store “relative path” 
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Metadata and License 

Metadata 
In general, Metadata are data that provides information about other data[122]. A description of the 

information in use is always useful but using GIS is crucial. “Similar to a library catalog record, metadata 

records document the who, what, when, where, how, and why of a data resource. Geospatial metadata 

describes maps, Geographic Information Systems (GIS) files, imagery, and other location-based data 

resources. The Federal Geographic Data Committee (FGDC), (USA), is tasked by Executive Order 12906 to 

enable access (see GeoPlatform.gov) to National Spatial Data Infrastructure (NSDI) resources and by OMB 

Circular A-16 and the A-16 Supplemental Guidance to support the creation, management, and maintenance 

of the metadata required to fuel data discovery and access.”[123] 

In Europe,”According to Article 5(1) of INSPIRE Directive 2007/2/EC, Member States shall ensure that 
metadata are created for the spatial data sets and services corresponding to the themes listed in Annexes I, 
II and III, and that those metadata are kept up to date. 

The Regulation as regards metadata (and subsequent amendments) and Technical guidelines set out the 
requirements for the creation and maintenance of this metadata”[124]. 

License 
When we use “data” we have to pay attention to the Terms and Conditions (in other world, the “license”) 

about the usage. 

Creative Commons, for example, has created several predefined licenses that help the user in a clear way 

 

Figure 218 - Creative Commons License - Compatibility Matrix 

                                                           
122 https://www.merriam-webster.com/dictionary/metadata 
123 https://www.fgdc.gov/metadata 
124 inspire.ec.europa.eu/metadata/6541 

https://www.fgdc.gov/
http://www.fgdc.gov/policyandplanning/executive_order
http://www.geoplatform.gov/
http://www.fgdc.gov/nsdi-plan
http://www.whitehouse.gov/omb/circulars_a016_rev#1
http://www.whitehouse.gov/omb/circulars_a016_rev#1
http://www.fgdc.gov/policyandplanning/a-16/index_html#supplemental-guidance
http://eur-lex.europa.eu/legal-content/EN/TXT/HTML/?uri=CELEX:32007L0002&rid=1
https://inspire.ec.europa.eu/Themes/Data-Specifications/2892
https://inspire.ec.europa.eu/Themes/Data-Specifications/2892
https://inspire.ec.europa.eu/Legislation/Metadata/6541
https://inspire.ec.europa.eu/Technical-Guidelines2/Metadata/6541
https://www.merriam-webster.com/dictionary/metadata
https://www.fgdc.gov/metadata
https://fortune.fm/blog/creative-commons/
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The CC Licenses 

All this section cames from Creative Commons[125] 

Attribution - CC BY 

“This license lets others distribute, remix, adapt, and build upon your work, even commercially, as long as 
they credit you for the original creation. This is the most accommodating of licenses offered. Recommended 
for maximum dissemination and use of licensed materials. 

View License Deed | View Legal Code 

 

Attribution-ShareAlike - CC BY-SA 

This license lets others remix, adapt, and build upon your work even for commercial purposes, as long as they 
credit you and license their new creations under the identical terms. This license is often compared to 
“copyleft” free and open source software licenses. All new works based on yours will carry the same license, 
so any derivatives will also allow commercial use. This is the license used by Wikipedia, and is recommended 
for materials that would benefit from incorporating content from Wikipedia and similarly licensed projects. 

View License Deed | View Legal Code 

 

 

 Attribution-NoDerivs - CC BY-ND 

This license lets others reuse the work for any purpose, including commercially; however, it cannot be shared 
with others in adapted form, and credit must be provided to you. 

View License Deed | View Legal Code 

 

 

 Attribution-NonCommercial - CC BY-NC 

This license lets others remix, adapt, and build upon your work non-commercially, and although their new 
works must also acknowledge you and be non-commercial, they don’t have to license their derivative works 
on the same terms. 

View License Deed | View Legal Code 

 

 

 Attribution-NonCommercial-ShareAlike - CC BY-NC-SA 

This license lets others remix, adapt, and build upon your work non-commercially, as long as they credit you 
and license their new creations under the identical terms. 

View License Deed | View Legal Code 

 

 

                                                           
125 https://creativecommons.org/licenses/ 

https://creativecommons.org/licenses/by/4.0
https://creativecommons.org/licenses/by/4.0/legalcode
https://creativecommons.org/licenses/by-sa/4.0
https://creativecommons.org/licenses/by-sa/4.0/legalcode
https://creativecommons.org/licenses/by-nd/4.0
https://creativecommons.org/licenses/by-nd/4.0/legalcode
https://creativecommons.org/licenses/by-nc/4.0
https://creativecommons.org/licenses/by-nc/4.0/legalcode
https://creativecommons.org/licenses/by-nc-sa/4.0
https://creativecommons.org/licenses/by-nc-sa/4.0/legalcode
https://creativecommons.org/licenses/
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 Attribution-NonCommercial-NoDerivs - CC BY-NC-ND 

This license is the most restrictive of our six main licenses, only allowing others to download your works and 
share them with others as long as they credit you, but they can’t change them in any way or use them 
commercially. 

View License Deed | View Legal Code 

 

 

We also provide tools that work in the “all rights granted” space of the public domain. Our CC0 tool allows 
licensors to waive all rights and place a work in the public domain, and our Public Domain Mark allows any 
web user to “mark” a work as being in the public domain”. 

 

  

https://creativecommons.org/licenses/by-nc-nd/4.0
https://creativecommons.org/licenses/by-nc-nd/4.0/legalcode
https://wiki.creativecommons.org/Public_domain
https://creativecommons.org/about/cc0
https://creativecommons.org/about/pdm
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Credits, Sitography and Links 

 361 Lectures (concepts) 

o http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/ 

 European Petroleum Survey Group (EPSG)[126] 

o http://www.epsg.org/ 

 GFOSS.it 
o www.gfoss.it 

 Google Search Operators: The Complete List (42 Advanced Operators) 

o https://ahrefs.com/blog/google-advanced-search-operators/ 

 QGIS.org 

o www.qgis.org 

 Wikipedia 

Lecture 

 Geographic Information System Basics [Book] 

o https://2012books.lardbucket.org/books/geographic-information-system-

basics/index.html 

 GIS in Sustainable Urban Planning and Management : A Global Perspective [Book]  

o http://oapen.org/search?identifier=1002491 

 Manual of Digital Earth [Book] 

o http://oapen.org/download?type=document&docid=1006981 

 Step-by-Step Guide to Vulnerability Hotspots Mapping: Implementing the Spatial Index Approach 

[Book] [ArcGIS] 

o http://www.ciesin.org/documents/vmapping_guide.pdf 

  

Data 

 Australia, World Heritage Areas 

o https://data.gov.au/dataset/ds-nsw-4000651a-96da-4f07-85a7-54cd54704aca/details 

 DATA.GOV 

o https://www.data.gov/ 

 Data Portal 

o https://dataportals.org/ 

 Diva GIS – Download data by Country 

o http://www.diva-gis.org/gData 

 European Commission, Eurostat, GISCO, Geodata 
o http://ec.europa.eu/eurostat/web/gisco/geodata  

 FAO Soil Database 
o https://www.isric.org/explore/soil-geographic-databases 

 Free GIS DATA 

o http://freegisdata.rtwilson.com 

 Geofabrik Map and Data (Openstreetmap Download) 

o http://www.geofabrik.de/ 

 Global Administrative Areas  - GADM maps and data 
o http://gadm.org/country 

 Global Forest Watch 

                                                           
126 EPSG stands for European Petroleum Survey Group. They publish a database of coordinate system information plus some very good related documents on map projections and 

datums. The Projection Engine uses a modified version of the EPSG model. POSC is the Petrotechnical Open Software Corporation 

http://www.geography.hunter.cuny.edu/~jochen/GTECH361/lectures/
http://www.epsg.org/
http://www.gfoss.it/
https://ahrefs.com/blog/google-advanced-search-operators/
http://www.qgis.org/
https://2012books.lardbucket.org/books/geographic-information-system-basics/index.html
https://2012books.lardbucket.org/books/geographic-information-system-basics/index.html
http://oapen.org/search?identifier=1002491
http://oapen.org/download?type=document&docid=1006981
http://www.ciesin.org/documents/vmapping_guide.pdf
https://data.gov.au/dataset/ds-nsw-4000651a-96da-4f07-85a7-54cd54704aca/details
https://dataportals.org/
http://www.diva-gis.org/gData
http://ec.europa.eu/eurostat/web/gisco/geodata
https://www.isric.org/explore/soil-geographic-databases
http://freegisdata.rtwilson.com/
http://www.geofabrik.de/
http://gadm.org/country
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o http://data.globalforestwatch.org/  

 Global Open Data Index 
o https://index.okfn.org/  

 

 ICPAC Geoportal 
o http://geoportal.icpac.net/  

 IPUMS INTERNATIONAL 
o https://international.ipums.org/international/gis.shtml  

 The Humanitarian Data Exchange (HDX) 

o https://data.humdata.org/ 

 Ireland Maps and Data 

o http://npws.ie/maps-and-data 

 National Heritage List for England (NHLE)  

o https://historicengland.org.uk/listing/the-list/data-downloads 

 OverpassTurbo (Extract Point of Interest from Openstreetmap) 

o https://overpass-turbo.eu/ 

 Protected Planet 

o https://www.protectedplanet.net 

 UNEP-WCMC - Resources & data 

o https://www.unep-wcmc.org/resources-and-data 

 UNEP-WCMC - World Heritage Sites KMZ File 

o https://www.unep-wcmc.org/resources-and-data/kml-file-of-world-heritage-sites 

http://data.globalforestwatch.org/
https://index.okfn.org/
http://geoportal.icpac.net/
https://international.ipums.org/international/gis.shtml
https://data.humdata.org/
http://npws.ie/maps-and-data
https://historicengland.org.uk/listing/the-list/data-downloads
https://overpass-turbo.eu/
https://www.protectedplanet.net/
https://www.unep-wcmc.org/resources-and-data
https://www.unep-wcmc.org/resources-and-data/kml-file-of-world-heritage-sites
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